Child Welfare Pre-Service Training

Case Planning FSFN Computer Instruction

Participant Guide

July 2013
PLEASE NOTE

Access to FSFN person or case information must only occur when there is a legitimate business purpose. FSFN must not be used to access any of the following:

- Persons or cases in the news, or
- Persons or cases about which you are “curious”, or
- Persons or information about your own personal case, or
- Persons or cases of family members, or
- Persons or cases of friends, neighbors or acquaintances, or
- Any other persons or cases for which there is no legitimate business reason for you to access the information.

Please use common sense when accessing FSFN; if you have any questions about the appropriate use of FSFN, please contact your supervisor and/or your agency’s IT Support personnel.

The materials for the Child Welfare Pre-Service Training curriculum were produced by Florida International University for the State of Florida, Department of Children and Families, Office of Family Safety.

© 2006 State of Florida, Department of Children and Families

The materials for the Child Welfare Pre-Service Training curriculum were formatted and edited by the Child Welfare Training Consortium at the University of South Florida.

© 2013 Child Welfare Training Consortium at the University of South Florida
## Table of Contents

**Module 1: Maintain Case/Person Management** ....................................................... 1  
Case Planning Scenario, Part I .................................................................................. 1  
Case Planning Scenario, Part 2 ................................................................................ 4  
Case Planning Scenario, Part 3 ................................................................................ 6  
Deactivating a Case Participant .................................................................................. 7  
Adding a Case Participant/Relationship ..................................................................... 8  
Adding Service Roles .................................................................................................. 9  
Updating Addresses .................................................................................................. 10  
Updating Person Information ..................................................................................... 13  
Create a Living Arrangement ..................................................................................... 14  
Updating the Safety Plan ........................................................................................... 15  

**Module 2: Family Assessment** ............................................................................. 1  
Family Assessment ..................................................................................................... 1  
Child Assessment ...................................................................................................... 5  
Adult Assessment ...................................................................................................... 11  

**Module 3: Case Plan** ........................................................................................... 1  
Case Plan: Case Plan Tasks ...................................................................................... 1  
Case Plan Goal .......................................................................................................... 14  
Second Level of Approval ......................................................................................... 21  

**Module 4: Independent Practice** ......................................................................... 1  
Case Planning Scenario Two ..................................................................................... 1  
Planning Worksheets: Case Planning Scenario Two .................................................. 10  

**PowerPoint Slides** .............................................................................................. Error! Bookmark not defined.
Module 1: Maintain Case/Person Management

Case Planning Scenario, Part I

FN1, Angela

An intake is received at the hotline on 08/26/2008 at 8:00am regarding the FN1, Angela Family and alleges that: “The mother, Angela, was under the influence of drugs while pregnant with her son, Fred. She and her paramour, John FN2, Fred’s father, use drugs and party late at night leaving the children unattended for long periods of time. Angela has two children, Christina, age 10 and Fred, an infant.”

There are no prior investigations on the family. Angela FN1 has no criminal history.

The intake was assigned to PI, Neil Roth. He commenced the investigation on 08/26/2008 at 9:33am, by responding to an abandoned home at 1317 Maple Street, MacClenny, FL 32063.

Neil speaks with the next door neighbor, Nelly Mathis, who stated that there was a pregnant woman with a small child living next door, but they recently moved into the blue house a few blocks down at 1321 Sunset Blvd. She said that when they lived next door, she observed high traffic in and out of the home by known neighborhood drug dealers. She expressed concern for the young child, as she was observed playing in the street late at night while the parents were having a party. Ms. Mathis reported that Christina often came to her home when her parents were parting because she was scared.

PI Neil Roth arrived at 1321 Sunset Blvd. and discovered a County Deputy Sheriff’s car in the yard. Angela’s paramour was being arrested for dealing cocaine from the home. Deputy Bradley Friendly reported they were responding to a tip that the paramour was selling drugs from the home. An undercover officer was able to purchase a large amount of cocaine from the paramour. Neil briefly interviewed the paramour in the back of the squad car and updated demographic data. The paramour, John FN2, confirmed that he is Fred’s father, but refused to provide any further statement to Neil. Deputy Friendly reported that John FN2 is currently on probation and has a long history of drug related arrests. He tells Neil that John is facing Violation of Probation and Possession charges and he does not expect him to be out of jail anytime soon.

PI Neil Roth interviewed Angela, who was crying and visibly upset due to John’s arrest. Angela admitted that she started using cocaine after losing her job in December, and has been using ever since. She stated that she only meant to use once to relieve stress, but continued to use with her new boyfriend, John FN2. She was unable to stop after she found out that she was pregnant. She stated that she stopped using when Fred was born and tested positive for cocaine. She volunteered to take a drug test, and stated that she has already called her mother, Shirley FN1, to move in and help her. No visible hazards are observed in the home and there is ample food and formula for the children.
PI Neil Roth interviewed Christina. She is excited that her grandmother is coming to stay at her house. Christina was challenging to interview and seemed unable to sit still. She stated that she loves her mother and is happy that John is gone. She said that she was scared of some of the people that come to the home to visit John. She states that she hopes her mother will play with her again now that her boyfriend is gone. She said the thing she likes most at home is when her mother cooks dinner for the family. She said she has been sad since her mom stopped cooking when John moved in with them. Neil observed Fred sleeping in his crib and he appeared with no observable signs of physical abuse. Angela stated that he is developing normally and does not appear to have any negative side effects from the drugs.

The grandmother, Shirley FN1, arrived at the home with her suitcase and stated that she is moving into the home to “help Angela get her life back together and provide a safe home for her children.” She stated that Angela was a good woman and mother before she got involved with John FN2, and that this was also when Angela started using drugs. She is confident that that she can help Angela get her life back together. Shirley agreed to contact the hotline if Angela relapses.

As Neil concluded the visit, Angela agreed to complete a drug screen and follow up with a drug evaluation. She stated that she is committed to her children and is willing to protect them from John. She also stated that if he is released from jail, she will not allow him back in the home. Angela tells PI that she is willing to sign a Non-Judicial In-Home Services Agreement.

On 08/28/2008: The Early Services Intervention/Case Transfer is held with the Community Based Care agency and you are the Case Manager assigned as the primary case worker.

On 9/02/2008: PI Neil Roth receives a phone call from Shirley stating that the mother, Angela, has not been home for three days and that she fears that Angela is on a drug binge. Shirley reports that Angela attended her drug evaluation on 8/29/08 but never returned. Shirley states that she can no longer stay at Angela’s house and must move back to her own home. She is willing to take Christina with her but cannot care for Fred. Neil agrees to go to the home at 4:00pm, and calls to update you. You agree to meet Neil at the house at 4:00pm.

On 09/02/2008 at 4:00pm: You arrive at the home and find PI Roth helping Shirley pack the children’s belongings. They inform you that Angela has not been home for three days and Shirley is sure that Angela has had a cocaine relapse. Shirley is afraid that Angela has gone back with John, who she thinks was recently released from jail. Shirley is willing to take the children but is not able to provide for them long term.

At 5:30pm: You and PI Roth visit Shirley’s home to complete an emergency home study for placement. The address is: 44 Sunny Lane, MacClenny, FL 32063.
When completing the home study, Shirley again states that she is not able to provide for the newborn baby, Fred. PI Roth and Shirley decide to have Christina live with her and to place Fred in a licensed home.

The children are removed from the mother’s home at 4:00pm. Christina is placed with Shirley at 5:30pm. Fred is placed in the home of a licensed provider, Ms. Nanny Seed, at 7:00pm.

At the shelter hearing on 09/03/2008: The court finds probable cause for removal from the mother’s home and approves the recommended placements for the children. The visitation plan is also approved. Christina’s father, James FN3 appears at the shelter hearing and requests placement/custody of Christina. The court indicates that Mr. FN3’s request will be approved upon receipt of a positive home study, and orders the home study. You initiate an Out of Town Inquiry (OTI) for a home study to be completed in Hillsborough County. James FN3 provides the following demographic information:

James (AD) FN3
565 South Street
Tampa, FL. 33511
813-123-1234
SS# 121-25-3363
DOB: 09/15/1981

You and your supervisor decide that Reunification with the mother is the appropriate permanency goal for both children.

On 09/03/2008: Nanny Seed takes Fred to his pediatrician, Dr. David Jones, at the Jefferson Pediatric Clinic. According to the physician, Fred is within normal weight and height limits for his age and presents with no apparent problems. All of his immunizations are up to date and you receive his records.

On 09/03/2008: Shirley takes Christina to her pediatrician, also Dr. David Jones at the Jefferson Pediatric Clinic; phone 947 - 444 - 4444. While Christina is within normal height and weight range for her age and presents with no physical health problems, Dr. Jones diagnoses her as having ADHD and prescribes Concerta 10mg to be taken every morning. She has 2 refills.

Photographs and fingerprints were taken of both children (footprints for Fred).
Case Planning Scenario, Part 2

FN1, Angela

On 09/05/2008: Case reviewed to update the information about the children. Angela calls you after Shirley informs her that the children were removed. You schedule an appointment for a Family Assessment and Home Visit on 09/08/2008. You also call the County Jail and they verify John FN2, Fred’s father, was released on 08/29/2008. The Jail does not have a forwarding address for John FN2.

On 09/08/2008 at 2:00pm: Home visit to Angela’s home to conduct the Family Assessment. Angela informs you that she completed her drug evaluation on 8/29/2008. That same day, John was released from jail and called her. Angela reported the reason that she did not return home for five days after her drug evaluations was because she became upset when the evaluator told her that she needed to go into inpatient treatment because she thought she would lose her children. She went to meet John and used cocaine again. She admits that she was with John over the entire holiday weekend and did not speak to her mother. She also admits that she used cocaine multiple times and drank excessively. Angela reported that John did not have a permanent residence and that he was moving from place to place. She reports that she has not seen or spoken to John since 09/02/08 and did not know where he currently was living.

Regarding her background, Angela states that she has an Associate of Arts in Business and had a good job at an insurance company until she was laid off in December 2007. Her parents divorced when she was 10 years old because her father was a violent alcoholic. She has not seen or spoken to her father since. She reports that Shirley has always supported her, especially when she got pregnant at 17. Even after her parents’ divorce, Shirley was always caring and made sure that she and her brother had everything they needed. Angela experimented with marijuana and cocaine in high school but once she became pregnant with Christina she knew she “had to get her life on track.” Angela knew Christina’s father for a short period of time and says that he was just someone she used to “party with.”

Angela complained that this seems to be the pattern with the men she meets, including her current boyfriend, John. She met John in a local pub shortly after she lost her job and, after a few weeks of dating, he reintroduced her to cocaine. When she realized that she was pregnant, she tried to stop using cocaine but couldn’t. She knew John was selling drugs from the home but didn’t know how to stop him. Angela said she “hoped that he would be different than Christina’s father.” Even though she did not agree with John selling drugs, it helped to pay the bills and she was out of a job. She stated “this would have never happened if I hadn’t gotten laid off.” Angela says that the children have been healthy and that she has not had to take them to the doctor for anything other than immunizations. Fred is developing normally and has not shown any side effects from the cocaine exposure and Christina has always been a healthy child.
Angela reports that Christina has received good grades in school until recently. She says that she is not sure why Christina’s school behavior and grades have worsened, but admits that it might be because of her drug use and John’s selling drugs out of their home. She admits that she has paid less attention to Christina since she became involved with John. She denies any arrest history, and says she knows that she made mistakes in her life, but feels that her life was pretty much on track until she got laid off. She acknowledges that getting laid off is no excuse and that she needs to get her life back on track for her children. Christina attends Palm Elementary School and Fred is at ABC Day Care.

**On 09/08/2008 at 4:00 pm:** A County Jail Inmate check revealed that John FN2 was rearrested on 09/06/2008 for violation of probation and public intoxication. Field visit to make contact with John FN2 at the Baker County Jail. Mr. FN2 was unavailable because he was meeting with his attorney as he was recently returned to jail after a brief release.

**On 09/09/2008 at 10:00 am:** Field visit to Palm Elementary. You speak with Ms. Anna Vasquez, the school guidance counselor. She states that during the last school year, Christina was a very good student and always seemed happy. Around January or February; however, she noticed that Christina began to withdraw and her grades began to slip. She met with Christina many times to try to help, but Christina would only say that she was tired and would provide no other reason for her behavior or her slipping grades. Christina got into a fight with a classmate in April which is completely uncharacteristic of her. Ms. Vasquez could not convince Christina to tell her why she hit the other child, but the other child told her that she had called Christina’s mother a “crack head.” Christina’s negative behavior patterns have continued into this school year, but she has noticed her demeanor improving over the last few days.

**On 09/09/2008 at 11:20 am:** Field visit to ABC daycare. You speak with Mrs. Jackson. Mrs. Jackson reports that she has no concerns about Fred, and that he is a “normal newborn.” She states that he always comes to daycare clean, and with plenty of diapers and food. He cries “no more than normal” and eats well.
Case Planning Scenario, Part 3

FN1, Angela

On 09/12/2008 at 11:10 am: Telephone call received from the Case Manager in Hillsborough County, Rachel Burke, regarding the home study results on James FN3, Christina’s father. Ms. Burke reports that Mr. FN3 has no criminal history and lives in a 3 bedroom 2 bath home with his paramour, Wendy FN4 (DOB 04/19/1982 SSN 477-85-3333), and their 3 year old son, Joshua FN3 (DOB 11/05/2005 SSN 683-55-1122). Ms. FN4 does not have a criminal history either. She is a kindergarten teacher and Mr. FN3 is active duty Air Force. They have sufficient income to support Christina. Mr. FN3 told Ms. Burke that he did not know about Christina until he received a call from Shirley FN1 late last year. He has reportedly been trying to contact Angela FN1 ever since learning that he has another child.

On 09/12/2008 at 11:30 am: Telephone contact with Shirley FN1. You advise her of the positive home study results. Shirley agrees to work with Mr. FN3 to schedule arrangements for Christina to move to his home.

On 09/12/2008 at 11:45 am: Telephone contact with Mr. FN3. You tell him that the home study was approved and that Christina will be placed with him. You notice him that a shelter hearing review is scheduled for 9/15/2008 at 9:00 am, and advise him that he can contact Shirley FN1 to make arrangements to pick up Christina.

On 09/15/2008 at 9:00 am: Shelter hearing review is held. The court approves Christina’s placement with her father. Hillsborough County will supervise the placement.

On 09/22/2008: Dependency petition filed with the court and served to all parties. The petition alleges Substance Exposure, Inadequate Supervision, Environmental Hazards, and Failure to Protect against the mother, Angela FN1. The allegations against John FN2 include Substance Exposure and Environmental Hazards.

On 09/30/2008 at 10:30 am: Arraignment hearing is held and both Angela FN1 and John FN2 consent to dependency. The Disposition Hearing is scheduled for October 10, 2008 at 11:00 am.

On 10/3/2008 at 9:30 am: A Family Team Conference/Case Plan Staffing is held with Angela FN1 and John FN2. Angela agrees to participate in outpatient substance abuse treatment and agrees that if she misses one appointment she will go into inpatient treatment. She also agrees to participate in parenting classes and individual counseling to help her better deal with stress, and to work with a job placement agency. John agrees to participate in a drug evaluation and follow through with all recommendations. He also agrees to participate in a parenting skills class. John is still awaiting trial on the drug charges. Both parents sign the Case Plan.
Deactivating a Case Participant

From the Desktop, click Cases Expando

Click the blue hyperlink for the FN1, Angela (AD) Case

From the Participant tab in the Participants group box, click the Deactivate hyperlink next to FN1, Shirley (AD)

The Participant Status pop-up box appears

From the Reason drop down box, select

Not a Caregiver
Enter 09/15/2008 in the Date Box

Click Save

A new inactive row with the end date appears

Click Close

A Reactivate hyperlink appears next to FN1, Shirley (AD)
Adding a Case Participant/Relationship

**Adding a Case Participant**

- From the Participant tab in the Participants group box
- Click Insert to display the Search Person page
- Click Search
- Click Create to display the Person Management page with the Basic tab open
- Click Save and Close
- Click Continue
- Click Save

**Adding a Relationship**

- Click on Relationship tab
- Click Insert and another subject box appears
- Click Save

- Choose FN4, Wendy (AD) from the dropdown box
- Choose a relationship for Wendy to Christina (Paramour-Parent/Caregiver)
- Choose Christina from the next blue subject box

Repeat the steps for FN3, Joshua (AD)
Adding Service Roles

From the **Participant** tab in the **Participants** group box

Add Service Role: **Paramour-Parent/Caregiver** for FN4, Wendy (AD)
Add Service Role: **Child Not Receiving Services** to FN3, Joshua (AD)

Click **Save**
Updating Addresses

Policy Regarding Case Addresses:

There are two places to update an address: Maintain Case Page and Person Management Page.

- If everyone is residing in the same home, the address is updated through the Maintain Case Page.
- If the participants’ addresses are different and services are not involved, the participants living with the primary caregiver are updated on the Maintain Case Page and other addresses are updated through the Person Management Page.
- If services are involved, update the address in Person Management, unless the Case Manager agrees that the new address is the legal address.

According to federal laws, there must be a case address, to be used by the courts to send legal documents. This is the primary caregiver’s address, in a removal situation, it is the removed from primary caregiver’s address.

*All Addresses must have a zip code.*

*Updates made later in the case may not be accepted if zip code is not entered at this time.*
Updating an Address

Click the Participants tab

Click blue hyperlink for FN4, Wendy (AD)

Go to the Address tab

Click Insert

A pop up box displays “All current addressed of the same type must be end dated before a new address of the same type can be saved. This action will save the person information. Do you want to continue? Click Yes.

Select Primary Residence as the Type
Select Street in the Street/PO Box/Route box

This brings up a screen.

Update address: 565 South Street, Tampa, 33511; Home Phone 813-123-1234

Click Save

The Postal Code 1 pop up box opens.
If you are sure the address is correct, check: Use entered address.

Click Continue

Click Close and Close again
Updating an Address

Click the **Participants** tab

Click blue hyperlink for **FN1, Christina (AD)**

Go to the **Address** tab

Click **Edit** on the current address

A pop up box displays "**This action will save the person information do you want to continue?**" Click **Yes**

End date the current address on 09/15/2008

Click **Save** and **Close**

Click **Save**

Select **Street** in the **Street/PO Box/Route Box**

This brings up a screen
Update address to the father’s address

Click **Continue**

The Postal Code 1 pop up box opens.
If you are sure the address is correct, check:
**Use entered address**

Click **Close** and **Close Again**
 Updating Person Information

On the Maintain Case screen, Click Participant tab

Click the Additional tab

To add a parent

Go to Additional tab
Update Child’s Father in Red

Click Search

Brings up Person Search Screen
Input Father’s name with correct Alpha Designator

Click Continue

Returns you to Maintain Case screen for Christina
Add information to the remaining tabs

Click Save & Close
Create a Living Arrangement

From the Desktop, Click the Cases Expando

Click the Case icon for the FN1, Angela (AD) Case

Click the Placement/Services icon

Click on the Out-of-Home hyperlink for FN1, Christina (AD)

From the Options dropdown box select Removal/Placement Ending. Click Go

Enter: End Date and Time: 09/15/2008 09:00AM
Enter: Ending Purpose: Discharge from Removal Episode
Enter: End Reason: Reunification w/Parent(s) Including Non-Custodial Parent
Enter: Discharge Reason: Reunification w/ Parent(s)/Primary Caretaker

Click Save and Close and Close again

Click Casework on the banner bar. From the Placement drop down box

Select Living Arrangement

Select Christina as case participant

Click the FN1, Angela (AD) case in the Cases box

Click Create and the Living Arrangements screen is accessed

Click Save and Close

Enter: Living Arrangement Begin Date and Time: 09/15/2008 09:01am
Choose Living with One Parent from the Living Arrangement dropdown box
Select FN3, James (AD) from Primary Caregiver dropdown
Choose all service reasons that apply
Updating the Safety Plan

From the Desktop, select Create on menu bar

Select Case Work from dropdown menu

From the Planning dropdown, select Safety Plan

Select FN1, Angela (AD) from list of cases in Case group box.

Click Create

In the Safety Factor Description group box

Pop-up box appears: “If this plan is created the current ongoing plan will become historical. Are you sure you want to continue?”
Click Yes

After the grandmother, Shirley FN1, moved into the home, on 08/29/2008, Angela FN1 attended her drug evaluation and did not return. On 09/02/2008, Shirley contacted the investigator to advise that Angela had not returned, after leaving three days prior, and she feared that Angela was on a drug binge as John FN2 had been released from jail. Shirley also stated that she could no longer stay at Angela’s house and that she was willing to care for Christina but could not care for Fred. The children were removed from Angela FN1 and John FN2’s custody. Fred was placed in licensed care and Christina was initially placed with her maternal grandmother, Shirley FN1. Christina’s father, James FN3, appeared at the shelter hearing and requested custody of Christina. Following an Out-of-Town Inquiry to Hillsborough County, which resulted in a positive home study, Christina was placed with her father, her father’s paramour, and half-brother in Tampa, FL.

In the Considerations group box

Select Yes to statements 1 & 3;
Select No to statements 2 & 4.

Click the Safety Actions tab

Enter the following narrative as a new paragraph:

The children were removed from Angela FN1 and John FN2’s custody on 09/02/2008. Fred was placed in licensed care and Christina was initially placed with her maternal grandmother, Shirley FN1. Christina’s father, James FN3 appeared at the shelter hearing and requested custody of Christina. Following an Out-of-Town Inquiry to Hillsborough County, which resulted in a positive home study, Christina was placed with her father, her father’s paramour, and half-brother in Tampa, FL.


**Updating the Safety Plan (cont.)**

In the second required field, enter the following narrative as a new paragraph:

The children could no longer remain in the mother’s custody as she left them with the grandmother without any provisions for their care. Angela will only be allowed supervised visitation with the children.

A pop-up box appears: “If you answered No to any of the four questions on the safety considerations tab, the child may be unsafe and require additional intervention including out-of-home placement.”

Select Safety Plan from the Options dropdown. Click Go.

On the Menu bar, click Close and Return to FSFN.

Click the Safety Considerations tab.

- Select Approval from the Options dropdown.
- Click Go.
- Select Approve.

Click Continue.

Click Save.
Module 2: Family Assessment

Family Assessment

From the Desktop, click Create from menu bar

Select Case Work from the dropdown menu

Select Family Assessment from Create Case Items window

Select FN1, Angela (AD) from the Cases group box

Click Create

On the Prior Intakes/Investigations tab scroll down to the bottom of the page and enter the following narrative:


Click Save

Click the Family tab

Select Reason for Agency Involvement and enter:

The mother, Angela was under the influence of drugs during her pregnancy with Fred. She and her paramour continue to use drugs and party late at night leaving the children unattended for long periods of time. The investigation revealed that John FN2 was arrested for selling cocaine, from the home, to an undercover officer.

In Describe the Family’s perspective on reason for Agency involvement, enter:

The mother, Angela, understood the reason for agency involvement and was actively participating in services at the time of case initiation. While initially cooperative, Angela eventually left the home for a week without notice and/or contact, reuniting with John FN2 upon his release from jail. She resumed her drug use during this week, and she left the children in the care of the grandmother without provisions for their care. Angela understands the reason why her children were removed from her care and the need to provide a safe environment for the children by stopping her drug usage.

Click Save
Select **Cultural on Family tab** → Select **Strength statements 1 and 2** → Select **Include in Case Plan for statements 1 and 2** → In the **Describe the Cultural Factors** field, enter:

There are no cultural or communication/language factors that negatively impact the children’s safety or the intervention strategies used with this family. The grandmother, Shirley, is supportive of Angela and protective of the children.

On the Family tab, select **Environmental Factors** → Select **Need** for statements 1 and 2 → In the **Describe the Environmental Factors** narrative field:

Angela’s substance abuse has affected her ability to adequately care for and supervise her children. Fred’s biological father, John FN2, was selling cocaine out of the home and was actively using cocaine in the home along with the mother. Angela was initially cooperative with services and agreed to participate in a drug evaluation, in an attempt to stop her drug usage; however, she ultimately relapsed and left the children in the care of the grandmother for one week, making no contact or provisions for their extended care. Angela has limited ability to manage stressors as she advised that the loss of her job triggered her drug usage.

Select **Input/Involvement on the Family Tab** → Click **Insert** → From the **Source Type** dropdown, select **School Officials** → Enter: **Ms. Anna Vasquez** in Name Source Field

In the **Date of Contact** field → Enter: **09/09/2008**

From the **Method of Contact** dropdown, select **Face-to-Face** → In the **Input Narrative** field, enter

Contact with Christina’s guidance counselor, Ms. Vasquez, revealed that Christina had always been a good student until the beginning of this year. During January/February Christina became withdrawn and her grades began to drop. She also advised that Christina struck another child when the child called her mother a “crack head.” Ms. Vasquez advised that since the involvement of the agency in the family’s life, Christina’s behavior and demeanor has improved significantly.
An initial safety plan was implemented at case initiation. The grandmother, Shirley, moved into the residence to provide support for Angela and to assure the children’s safety. In addition, John FN2, was incarcerated and both Angela and Shirley agreed to prevent John access to the home and children and to notify authorities in the event that he returned to the home. Angela completed a drug evaluation, but relapsed, leaving the children in the care of her mother with no contact and/or provisions for their extended care. Angela reunited with John and resumed her drug usage. This resulted in the children being removed from her care pending additional intervention.

Angela completed a drug evaluation which recommended her participation in inpatient treatment. Angela was unable to cope with this recommendation and left the facility, failing to return home. She was away from the home for one week, during which she reunited with John FN2 and continued her drug and alcohol abuse. During this week, she failed to communicate with her mother and/or agency staff and failed to make extended provisions for the children’s care. This ultimately led to the removal of the children.
John FN2 was arrested for possession and selling drugs to an undercover officer from Angela’s home. Angela admitted to using cocaine which was supplied by John. She has no source of income and was willing to allow John to sell drugs from her home in order to be able to meet the children’s basic needs. Angela initially agreed to In-Home Services and completed a drug evaluation. The evaluation recommended inpatient treatment, which upset Angela and she relapsed. She reunited with John during his brief release from jail and continued to use cocaine and alcohol. Angela left her children with her mother and failed to communicate and/or return, making no extended provisions for the care of the children. The grandmother contacted the agency and advised that she could no longer stay in Angela’s home and that she was unable to provide for Fred on a long term basis due to his age. Both children were removed from the care of the mother and Christina was temporarily placed with the grandmother, Shirley, and Fred was placed in licensed care. A shelter hearing was held and the judge signed the shelter order. James FN3 was present at the shelter hearing and requested physical placement of Christina. The judge advised that this placement could occur following the completion of a positive home study. On OTI from Hillsborough County was requested. The results were positive and Christina was place with her father.
Child Assessment

Click the **Child** hyperlink for FN1, Christina (AD) → For the question, "Is the child in out of home placement?" Select Yes → In the Narrative text field

Christina was placed with her maternal grandmother, Shirley. Shirley could not care for Fred and he was placed in a licensed home. Shirley has played a significant role in Christina’s life and Christina is very close to her grandmother. Shirley’s home is a few miles away from Angola’s home and Shirley has agreed to supervise visitation. Shirley has stated that she cannot care for Christina long term. Christina’s father, James FN3, appeared at the shelter hearing and requested placement with him. An OTI has been initiated with Hillsborough County for completion of a home study and local background checks. The results were positive and Christina was placed with her father.

Select **Permanency** in the Factors group box → In Describe Efforts to Achieve Permanency text field enter:

Continued efforts have been made to ensure parental involvement in all decisions regarding the children. Based on Angela’s level of cooperation and efforts to address her substance abuse, reunification is the recommended goal. Christina has been placed in her father’s home.

Click the **Well-Being** tab → Select **Health** → Select **Strength for all statements** → Select Include in Case Plan for all statements

In the **Describe the Implications of Health Factors** text field enter:

Christina’s pediatrician is Dr. David Jones at Jefferson Pediatric Clinic. Christina is in good physical health and has received all necessary preventative health care.

Select **Behavioral Health** on the **Well-Being** tab → For questions 1 and 2, select **Need** → For statement 1, select include in case plan

In the **Describe the Implications of Behavioral Health factors** text field enter:

Christina has been diagnosed with ADHD by Dr. Jones and was prescribed Concerta. Christina’s guidance counselor also reported that prior to agency involvement, Christina had become withdrawn and had recently fought with a classmate.
Select **Education the Well-Being tab**

- For statement 1, select **Need**
- For statement 2, select **Strength**
- For statement 3, select **No**

Select **Include in Case Plan for statements 1 and 2**

In the **Describe the Implications of Educational Factors** narrative text field enter:

Christina was a good student; however, her grades began to drop recently. The guidance counselor reported that Christina also became withdrawn around the same time that her grades deteriorated.

Select **Social**

- For statements 1, 2, and 3 select **Strength**
- Select **Include in case plan for all statements**

In the **Describe the Implications of Social Factors** narrative text field enter:

Christina had always been outgoing and had many friends in school and in the neighborhood. Her behavior was appropriate and she was not a discipline problem. However, prior to agency involvement she became withdrawn, was involved in a fight with another student and appeared unable to cope with her family situation. Agency involvement with the family has resulted in her behavior improving and Christina returning to her normal outgoing and well-behaved self.

Click the **Vulnerability tab**

- Select **Fragility on Vulnerability tab**
- Select **Strength for statements 1, 2 and 4**
- Select **Need for statement 3**
- Select **Include in case plan for statements 1, 2 and 4**

In the narrative text field enter:

Christina does not have any involvement with law enforcement nor does her age or functioning level affect her ability to self-protect. Christina was exposed to both drug use and drug trafficking in the home. Christina has been diagnosed with ADHD which increases her vulnerability.

Select **Behavior on the Vulnerability tab**

- For statement 1, select **Yes**
- Select the checkbox **Withdrawn/Lethargic** from the next group of behaviors

Christina’s behavior with teachers and classmates has been withdrawn for approximately nine months. Prior to that, Christina was an appropriate, well-behaved student with many friends. The guidance counselor has recently noticed an improvement in Christina’s behavior.
Select Adjustment in the Factors group box

For statements 1, select Need
For statements 2 and 3, select Strength
Select Include in Case Plan for statements 1, 2, and 3

In the Describe the adjustment factors and any change the child wants to make in their family home narrative text field

Christina became withdrawn and her grades began to drop when her mother started using drugs and John moved into the home. Christina and her grandmother, Shirley, are very bonded and there have been no problems noted with her current placement. Prior to the children’s removal, Shirley had moved into the home to try to help Angela get her life back on track and to ensure that the children were safe.

In the Case Header group box, select Completed

Click Save to begin the system validation
Click Close and the Family Assessment screen displays

Click the Child Hyperlink for FN1, Fred (AD)

For the question, “Is the child in an out-of-home placement?”, select Yes
In the narrative field enter:

Fred was placed in a licensed home following the removal of the child from the care of the mother, Angela. The maternal grandmother, Shirley, was unable to provide care for Fred due to his age and he was subsequently placed into licensed care. Fred’s father, John, remains incarcerated and is subsequently unable to provide care for the child.

Select Permanency in the Factors group box

In Describe efforts to achieve Permanency enter:

Continued efforts have been made to ensure parental involvement in all decisions regarding the children. Based on Angela’s level of cooperation and efforts to address her substance abuse, reunification is the recommended goal. Fred’s father is currently incarcerated and unable to provide for Fred’s care.
Fred has been seen by Dr. David Jones at Jefferson Pediatric Clinic since birth. He has received all required preventative care and is up to date with his required immunizations. The child is reportedly in good health and within normal developmental milestones. There appear to be no health issues associated with the child being exposed to drugs prior to birth.

Fred is very young and displays normal behaviors associated with age related milestones. The child attends daycare and has adjusted well to his new routine. He is responsive to the daycare employees and displays age appropriate behavior.

Fred attends ABC Daycare Monday through Friday from 7:30 am to 5:30 pm. Fred has not had any unexcused or excused absences and shows no evidence of developmental delays.
Module 2: Family Assessment

In the **Describe the Implications of Social Factors** narrative text field enter:

Fred displays age appropriate activities and has developed appropriate bonds and connections to daycare employees as well as his out-of-home care provider. He has supervised visits with his mother, Angela, and continues to respond to her care and nurturing.

In the narrative text field enter:

Fred is too young to have any involvement with law enforcement and/or juvenile justice. Due to his age he is unable to self protect and must be supervised at all times. Fred was exposed to cocaine and alcohol prior to his birth; however, he has not displayed any negative developmental issues related to this exposure to date. Fred’s age increase his vulnerability as he is too young to talk and unable to meet any of his needs.

In the Other Risk Factors text field enter:

Fred’s behavior is consistent with the developmental milestones associated with his age range. He presents as an active and happy baby.
Select **Adjustment** in the **Factors** group box

For statements 1, 2 and 3, select **Strength**

Select **Include in Case Plan** for all statements

In the Describe the adjustment factors and any change the child wants to make in their family home narrative text field

Fred appears to be adjusting to his placement in out-of-home care. He has bonded with his out-of-home care provider, daycare staff and continues to have supervised visitation with this mother. He has an established routine that appears to make him feel stable and secure.

In the **Case Header** group box, select **Completed**

Click **Save** to begin the system validation

Click **Close** and the **Family Assessment** screen displays
Adult Assessment

Click the Adult hyperlink for FN1, Angela (AD) → Select Health and review the Health group box on Functioning tab → For questions 1 and 2, select Strength → Select Include in case plan for all statements → In the Describe the implications of health factors and the impact of any physical disabilities. Also consider the effects of any prescribed medications narrative text field

The mother, Angela, has no known physical health problems, but she uses drugs.

Select Behavioral Health on Functioning tab → For statements 1 & 2, select Strength → For statements 3 & 4, Need → For 1, 2, and 3, select Include in case plan.

In Describe the Implications of Behavioral Health Factors and the Impact on any Physical Disabilities text field enter:

Angela does not have any documented behavioral/mental issues that impact her ability to parent or protect her children. She has a local physician, Dr. Jorge Garcia, who provides her with yearly check-ups and urgent care when necessary. At the time of initial contact, Angela admitted to using cocaine for an extended period of time. She also admitted to excessive alcohol consumption. She permitted Fred’s father to use and sell cocaine from the family home. This resulted in an increased vulnerability to her children as did her addiction to cocaine. Angela completed her drug evaluation; however, relapsed shortly after, resulting in the removal of her children.

Select Intellectual on the Functioning tab → For statement 1, select the Strength → Select include in case plan for all statements → In the narrative text field enter:

Angela has completed high school and also attained an Associates of Arts in Business. Her intellectual functioning does not negatively impact on her ability to protect and care for her children. She understands her need to stop using drugs and provide her children with a safe environment.

Select Communication on Functioning tab → For questions 1 & 2, select Strength → Select Include in case plan for all statements → In the narrative field enter:

Angela reads and writes English fluently and is able to effectively communicate with her children and service providers.
According to Angela her father was a violent alcoholic; however, her mother divorced the father due to the violence and addiction. Angela was ten years of age when her parents divorced and he has had no contact with her since that time. She advised that her mother, Shirley, has always been a caring and supportive parent and that she never abused or neglected her during her childhood or adolescence. Angela has no history of perpetrating abuse or neglect.

Angela FN1 has no criminal history.

Angela was employed at a local insurance company until December when she was laid off. She has been unemployed since that date. After the loss of her job, the primary source of income was Fred’s father, who was selling drugs from the home. Currently, Angela has no verifiable source of income.

There are no prior reports involving any type of domestic violence on any of the involved subjects and/or address. Angela advised that other than her father’s violence during the first ten years of her life, she has neither been victimized or perpetrated any type of domestic abuse. Her current paramour, John, denied any type of domestic abuse. His criminal history did not reflect any incidents of domestic abuse.
Select **Dynamics** in the **Factors** group box on the **Relationships** tab

For statements questions 1 & 2, select **Need**

For statement 3, select **Yes**

For statements 4 & 5, select **Need**

*In the Describe the relationship dynamics including marital history narrative field, enter:*

> Angela is currently involved in a relationship with John FN2 that is focused on substance abuse. She advised that he was the individual who exposed her to drugs and continued to provide her with the drugs. In addition, she permitted John to live in her home and to use and sell illegal drugs from the residence. She was unable to prevent him from using her home to sell drugs and allowed her children to be exposed to drug usage. Initially she agreed to abstain from drug usage and to avoid any continued involvement with John FN2; however, she relapsed and reunited with John, and continued the use of drugs. Angela is now committed to remain drug free and John FN2 is incarcerated.

Angela had a short relationship with James FN3, Christina’s father. They dated briefly until he left for the Air Force. He had no idea that she was pregnant and Angela did not see the need to disclose this to James.

Select **Support Networks** in the **Factors** group box on the **Relationships** tab

For statements 1 & 2, select **Strength**

*In the narrative field, enter:*

> Angela FN1 has received extensive support from her mother, Shirley. In addition, she currently has several friends and an AA sponsor who are assisting her in her recovery.

Click **Parenting** tab. Select **Protective Capacities** in the **Factors** group box

For statements 1, 2 & 5, select **Need**

For statements 3 & 4, select **Strength**

For statements 2, 3, 4 & 5, select **Include in case plan.**

*In the narrative field, enter:*

> Angela began to use drugs after she lost her job in December. She allowed John FN2 to move into her home and to use and sell drugs. Angela admitted that she knew that this was harmful to her children but she was unable to stop it and it paid the bills. Angela is attached to both of her children and has provided for their basic needs; however, by allowing Fred’s father to sell drugs from the home she failed to protect them from harm. Angela is currently motivated to protect her children and to comply with all of the restrictions necessary to assure their safety.
Select the **Expectations of Child** in the **Factors** group box

Select **Strength** for statements 1, 2, and 3

For all statements, select **Include in case plan**.

In the narrative text field enter:

Angela appears to have a good understanding of age appropriate disciplinary techniques. Prior to her substance abuse she effectively parented Christina, utilizing appropriate strategies to set and reinforce limits, and managing Christina’s behavior. She also has appropriate expectations for the care of Fred and has provided him with the love and care required by a newborn.

Select **Participation** in the **Factors** group box

Select **Strength** for all statements

For all statements, select **Include in case plan**.

In the **Describe participation factors and identify any barriers** narrative text field enter:

Angela understands the need for intervention and the severity of the maltreatment. Angela has been active in her service participation, following a brief relapse following case initiation. She has resumed her treatment plan and has completed timely follow-ups with all referrals. Angela’s behavior is beginning to reflect positive changes.

In the **Case Header** group box select **Completed**

Click **Save**

Click **Close**

From the **Options** dropdown, select **Family Summary** on the **Participants** tab. Click **Go**

Click **Close** and Return to FSFN

Click **Close**, then **Close** again to return to the Desktop
Adult Assessment

Click the Adult hyperlink for FN2, John (AD)

Select Health and review the Health group box on Functioning tab

For questions 1 and 2, select Strength

Select Include in case plan for all statements

In the Describe the implications of health factors and the impact of any physical disabilities. Also consider the effects of any prescribed medications narrative text field

John appears to be in good health; however, he appears to have an untreated substance abuse issue.

Select Behavioral Health on Functioning tab

For statements 1 & 2, select Strength

For statements 3 & 4, select Need

For 1 and 2, select Include in case plan.

In Describe the Implications of Behavioral Health Factors and the Impact on any Physical Disabilities text field enter:

John does not have any documented behavioral/mental issues that will impact his ability to parent Fred. He advised that he only goes to a doctor when he requires prescription medications. At the time of initial contact John was being arrested for possessing and selling cocaine to an undercover police officer. John also has numerous other drug related arrests, revealing a long history of drug usage. John admitted to openly using drugs in the family home and is facing criminal charges alleging selling cocaine from the family home. This resulted in an increased vulnerability to his child as did his addiction to cocaine. John remains incarcerated at the time of this assessment.

Select Intellectual on the Functioning tab

For statement 1, select Strength

Select include in case plan for all statements

In the narrative text field enter:

John appears to be of average intelligence. Due to his refusal for an interview, an extensive knowledge of his educational record is not available.

Select Communication on Functioning tab

For questions 1 & 2, select Strength

Select Include in case plan for all statements

John is able to read and write English and is able to effectively communicate with other individuals.
John's childhood history is unknown. John was selling drugs from the family home, placing the children at risk.

Select Criminal on the History tab.

For statements 1 and 2 select Need.

For statement 1 select Include in case plan.

In the narrative field, enter:

John has multiple drug related arrests.

Select Financial on the History tab.

Select Need for statements 1 and 2.

Select Include in case plan for statement 2.

In the narrative field, Describe the individual's employment history and ability to manage financial resources enter:

John's only source of income was selling narcotics. He does not have a recent history of employment and has no other verifiable source of income.

Select the Relationships tab.

Select Domestic Violence in the Factors group box.

For statement 1, 2, 3 and 4 select Strength.

For all statements, select Include in case plan.

In the narrative field, Describe any domestic violence experience as victim or aggressor narrative text field enter:

There are no prior reports involving any type of domestic violence on any of the involved subjects and/or address.
Select **Dynamics** in the **Factors** group box in the **Relationships** tab

For statements 1 & 2, select **Need**

For statement 3 select **Yes**

For statements 4 & 5 select **Need**

In the **Describe the relationship dynamics including marital history** narrative field enter:

John’s current relationship with Angela appears to be focused on substance abuse. He did not appear to be an active participant in their relationship unless it was to help Angela continue to use drugs and to use Angela’s home as his base for selling drugs. He did not appear to be actively involved in the care of his son and appears to be using and selling drugs to resolve his relationship and financial problems.

Select **Support Networks** in **Factors** group box on **Relationships** tab

For statements 1 & 2, select **Need**

In the narrative field enter:

John denies having any family members in the area. All of his current friends appear to be involved with drug use and/or drug dealing.

Click **Parenting** tab. Select **Protective Capacities** in the **Factors** group box

For all statements select **Need**

For statement 1 select **Include in case plan**.

In the narrative field enter:

John failed to provide a safe environment for his son, Fred, by using drugs in the home environment. In addition, he also sold drugs from the family home further increasing the child’s vulnerability. He was minimally involved in the care of his infant son and is currently incarcerated and unable to meet the child’s needs.
Select **Expectations for Child** in the Factors group box → Select **Need** for all statements → In the narrative text field enter:

John appears to have left Fred’s care to Angela. He appears to have been minimally involved in Fred’s parenting and does not appear to understand how to provide care and support for a newborn.

Select **Participation** in the Factors group box → Select **Need** for all statements

In the **Describe participation factors and identify any barriers** narrative text field enter:

John FN2 is currently incarcerated, pending charges of cocaine trafficking. Services are not currently available to John, nor has he expressed an interest in obtaining services.

In the **Case Header** group box select **Completed** → Click **Save** → Click **Close** → From the **Options** dropdown, select **Family Summary** on the **Participants** tab. Click **Go**

Click **Close and Return to FSFN** → Click **Close**, then **Close** again to return to the Desktop
Adult Assessment

Click the Adult hyperlink for FN3, James (AD)

Select Health and review the Health group box on Functioning tab

For questions 1 and 2, select Strength

Select Include in case plan for all statements

In Describe the implications of health factors and the impact of any physical disabilities. Also consider the effects of any prescribed medications narrative text field

John is in good health. He receives annual physicals as a result of being in the Air Force.

Select Behavioral Health on Functioning tab

For all statements select Strength

For all statements, select Include in case plan.

In Describe the Implications of Behavioral Health Factors and the Impact on any Physical Disabilities text field enter:

James does not have any documented behavioral/mental issues that impact his ability to parent Christina. His involvement in the Air Force forces him to have regular assessments and evaluations. He denied any type of substance abuse issues. Record checks revealed no history of substance related issues with James or with the home location.

Select Intellectual on the Functioning tab

For statement 1, select Strength

Select include in case plan for all statements

In the narrative text field enter:

James appears to be of average intelligence. He completed high school and immediately left for the Air Force.

Select Communication on Functioning tab

For questions 1 & 2, select Strength

Select Include in case plan for all statements

James is able to read and write English fluently and is able to effectively communicate with other individuals.
Click History Tab, Select Abuse

For statements 1 & 2, select Strength

For all statements, select Include in case plan.

In the narrative field

James denied any history of abuse as a child or an adult. He has no history as a victim or a perpetrator.

Select Criminal on the History tab

For statements 1 & 2, select Strength

For all statements, select Include in case plan.

In the narrative field

James has no criminal history.

Select Financial on History tab

For statements 1 & 2, select Strength

For all statements, select Include in case plan.

In the narrative field Describe the individual’s employment history and ability to manage financial resources

James has the financial capacity to support his current family and Christina.

Select the Relationships tab.

Select Domestic Violence in the Factors group box.

For statements 1, 2, 3 & 4 select Strength

For all statements select Include in case plan.

In the Describe any domestic violence experience as victim or aggressor narrative text field enter

There are no prior reports involving any type of domestic violence on any of the involved subjects and/or address.
Select **Dynamics** in the **Factors** group box on the **Relationships** tab → For statements questions 1 & 2, select **Strength** → For statement 3, select **Yes** → For statements 4 & 5, select **Strength** → For all statements, select **Include in Case Plan**.

In the **Describe the relationship dynamics including marital history** narrative field, enter:

James currently resides with his paramour, Wendy FN4, and their 3 year old son, Joshua. Neither report any relationship problems and they were observed to interact appropriately.

Select **Support Networks** in the **Factors** group box on the **Relationships** tab → For statements 1 & 2, select **Strength** → For statements 1 & 2, select **Include in Case Plan**.

In the narrative field, enter:

James has a support system within his home and also has extended family in the neighborhood. He is on active duty with the Air Force and has many friends and co-workers that he is able to rely on for assistance if necessary. In addition, many of these family members and friends have children and are willing to assist James in the care of Christina. James is currently raising a child with his paramour Wendy, and they discussed their methods of discipline and parenting strategies currently used.

Click **Parenting** tab. Select **Protective Capacities** in the **Factors** group box → For all statements, select **Strength** → For all statements, select **Include in Case Plan**.

In the narrative field, enter:

James is willing to protect his daughter and provide for her needs. He is fully aware that Angela is only to have supervised contact with Christina until the court orders otherwise. He has adequate space for the child and his current paramour is willing to assist in the care of the child. They feel that their current methods of parenting will be adequate to address Christina’s age level.
James was observed interacting with his 3 year old child and appeared to understand the needs and behaviors associated with a 3 year old. He believes in the use of time out and understands the need for consistent rules and consequences. He acknowledged that he has not had to parent an older child, but felt that his current parenting techniques could be adapted to meet the needs of Christina. His military background appears to have an impact on his need for order and discipline; however, he appears to be very loving and caring towards his son. James stated that he was “shocked” to find out that he had another child and understood his responsibility to care for Christina. He advised that he and his current paramour, Wendy, agree that it is his responsibility and both are fully prepared to take on the care of Christina.

James is aware that Christina will need to participate in counseling and will assure that all of her current and ongoing needs are met.
Module 3: Case Plan

Case Plan: Case Plan Tasks

- From the Desktop page, click Create on menu bar
- Select Case Work from dropdown menu
- From the Planning dropdown select Case Plan Task
  - Select FN1, Angela (AD) from the list of cases in Cases group box.
  - Pop-up box appears: A pending Family Assessment exists, Do you want to continue?
  - Click YES
  - Second pop up “Do you want to create a case plan tasks from the most recent family assessment?” Click Yes
- In the Case Plan Tasks Information group box – Expiration Date field
  - Enter: 09/03/2009
- In the Purpose dropdown
  - Select: Initial Case Plan
- On the Participants Tab, next to the Mother's Name
  - Select: The mother from the participants dropdown box
- Click Save
Module 3: Case Plan

Case Plan: Case Plan Tasks

1. Click Insert in the Father(s) group box
2. Select the father from the participants dropdown box.
   - Click YES next to the question, “Is father being given case plan tasks at this time?”
3. Repeat the process if there is more than one father
4. Click Save
5. Review the Strengths tab
6. In the Summarize Family Strengths field enter:

   Angela is in good physical health, but uses drugs. Angela has not been diagnosed with any mental health conditions. Angela reports that her mother, Shirley FN1, has always been very supportive. Angela has no prior history of perpetrating abuse or neglect. Angela is committed to remaining drug free. Angela is attached to her children and provided for their basic needs. Angela has a good understanding of appropriate disciplinary techniques and shows sound judgment in this area. Angela understands the need for intervention and the severity of the maltreatment. Angela has been active in her follow-up with all referrals and is beginning to reflect positive changes in her day-to-day behavior.

   Mr. FN3 is willing to protect his daughter, Christina, and to provide for her. He is fully aware that Angela is only to have supervised contact with Christina until notified otherwise by the court.

7. Click Save
8. Click Needs tab
9. If the Reason for Agency Involvement was not carried over from the Family Assessment in the narrative text field, enter:

   The mother, Angela, was under the influence of drugs while she was pregnant with Fred. She and Fred’s father, John, used drugs and partied late at night leaving the children unattended for long periods of time. The investigation revealed that John FN2 was arrested for selling cocaine to an undercover officer.

10. Click Save
In Case Participants Needs group box: Click the Edit hyperlink for FN1, Angela (AD) that states “Substance abuse issues impact the family, their ability parent, or protective capacities.”

In the Identified Problem narrative text field, enter:

The mother, Angela, was under the influence of drugs while she was pregnant with Fred. She and the child’s father, John, used drugs and parted late at night leaving the children unattended for long periods of time.

In the Begin Date field: Enter: 10/03/2008

In the Target Date field: Enter: 07/03/2009

In the Specific Task group box, click Insert. In the Desired Measurable Behavioral Outcome narrative text field, enter:

The mother, Angela, will provide her children with an environment that is free from substance abuse.

In the Specific Task narrative text field, enter:

The mother, Angela, will participate in weekly out-patient substance abuse treatment. If Angela misses one appointment for out-patient treatment, she will participate in in-patient treatment until deemed no longer necessary.

In the Steps to Complete Task narrative text field, enter:

The mother, Angela, will contact Gateway to schedule an appointment.

In the Frequency field: Enter: Weekly

In the Specific Task Begin Date field: Enter: 10/03/2008

In the Estimated Cost field: Enter: $500

In the Specific Task End Date field: Enter: 07/03/2009
Click the **Search** hyperlink to find a Provider → In the **Provider/Organization Name field** → **Enter: Gateway**

- Click **Search** → Select: **Gateway Comm Serv**
- Click **Continue** → In the **Person Responsible field** → **Enter: FN1, Angela (AD)**

From the **Service Category** Select: **Routine/Emergency Services checkbox**

From the **Service Type field** Select: **Outpatient Individual - Substances**

- Click **Save** → **Click Insert**
  - Message box appears “Are you sure you want to delete this entry?”
  - **Click YES**

Click the **Delete** hyperlink → **Click Save and Close**

On **Needs** tab, click **Delete hyperlink** on the statement “Motivated to protect the child” → In the **Case Participant Needs group box**

Click **Edit** hyperlink for FN1, Angela (AD), “Current legal financial resources insufficient to meet basic needs.” → In the **Identified Problem narrative text field, enter:**

Angela FN1 has been unemployed since December of 2007 and has been unable to financially support herself and her children. The family’s only source of income came from John FN2 selling narcotics from the home.
In the **Begin Date** field Enter: 10/03/2008

In the **Target Date** field Enter: 07/03/2009

In the **Specific Task** group box, click **Insert**. In the **Desired Measurable Behavioral Outcome** narrative text field enter:

> Angela FN1 will be able to financially provide for her children’s needs.

In the **Specific Task** narrative text field enter:

> Angela FN1 will obtain and maintain a verifiable source of income sufficient to meet her children’s needs.

In the **Steps to Complete Task** narrative text field enter:

> Angela FN1 will provide her Case Manager with pay stubs on a monthly basis.

In the **Frequency** field Enter: Monthly

In the **Specific Task Begin Date** Enter: 10/03/2008

In the **Specific Task End Date** Enter: 07/03/2009

In the **Person Responsible** field Enter: FN1, Angela (AD)

Click **Save and Close**
In the Case Participant Needs group box, click the Edit hyperlink for FN1, Angela (AD) that states "Unable to meet child's needs for food/nutrition, hygiene, health, shelter, and education; and supervise the child's activities to prevent harm.

In the Identified Problem narrative text field enter:

Angela FN1 allowed John FN2 to sell narcotics from the home. Angela FN1 admitted to using cocaine and neglecting to supervise her children.

In the Begin Date field Enter: 10/03/2008

In the Target Date field Enter: 07/03/2009

In the Specific Task group box, click Insert. In the Desired Measurable Behavioral Outcome narrative text field enter:

Angela FN1 will provide her children with a living environment that is free of substance abuse and will provide her children with age appropriate adult supervision.

In the Specific Task narrative text field enter:

Angela FN1 will complete a parenting class with 100% attendance and will demonstrate the skills learned during supervised visitation with her children.

In the Steps to Complete Task narrative text field enter:

Angela FN1 will contact Child Guidance Center to enroll in a parenting class.

In the Frequency field Enter: Weekly

In the Specific Task Begin Date Enter: 10/03/2008

In the Specific Task End Date Enter: 07/03/2009

In the Other Provider/Ongoing Service Worker field Enter: Child Guidance

In the Person Responsible field Enter: FN1, Angela (AD)

From the Service Category field Select: Basic Parenting Assistance

From the Service Type field Select: Parenting Education - Classes

Click Save and Close
In the **Case Participant Needs** group box

Click the **Edit** hyperlink for **FN2, John (AD)** that states “History of illegal activity, arrests or law enforcement involvement.”

In the **Identified Problem** narrative text field enter:

John FN2 has numerous drug related arrests.

**Begin Date** field Enter: 10/03/2008

**Target Date** field Enter: 07/03/2009

In the **Specific Task** group box, click **Insert**. In the **Desired Measurable Behavioral Outcome** narrative text field enter:

John FN2 will provide his son, Fred, with an environment that is free from illegal activities.

In the **Specific Task** narrative text field enter:

John FN2 will not engage in illegal activities, specifically selling narcotics or any other drug related offenses.

In the **Steps to Complete Task** narrative text field enter:

John will allow his assigned Case Manager or other authorized agency employee to visually inspect his home. John will immediately and continuously provide the names, dates of birth, and social security numbers for all individuals residing in the home and/or any frequent visitors to the home to his assigned Case Manager so that timely background investigations may be completed.

**Frequency** field Enter: Ongoing

**Begin Date** Enter: 10/03/2008

**End Date** Enter: 07/03/2009

**Person Responsible** field Enter: FN2, John (AD)

Click **Save and Close**
In the **Case Participant Needs** group box

Click the **Edit** hyperlink for FN2, John (AD) that states “Current legal financial resources insufficient to meet basic needs.”

In the **Identified Problem** narrative text field enter:

John FN2 is currently unemployed. His only source of income is selling narcotics from the home.

In the **Begin Date** field

**Enter:** 10/03/2008

In the **Target Date** field

**Enter:** 07/03/2009

In the **Specific Task** group box, click **Insert**. In the **Desired Measurable Behavioral Outcome** narrative text field enter:

John FN2 will be able to financially provide for Fred’s needs.

In the **Specific Task** narrative text field enter:

John FN2 will obtain and maintain a verifiable source of income sufficient to provide for Fred’s needs.

In the **Steps to Complete Task** narrative text field enter:

John FN2 will provide his Case Manager with pay stubs on a monthly basis.

In the **Frequency** field

**Enter:** Monthly

In the **Specific Task Begin Date**

**Enter:** 10/03/2008

In the **Specific Task End Date**

**Enter:** 07/03/2009

In the **Person Responsible** field

**Enter:** FN2, John (AD)

Click the **Save** button and then the **Close** button.
In the **Case Participant Needs** group box

Click the **Edit** hyperlink for FN2, John (AD) that states "Does not understand and cannot identify harmful situations."

In the **Identified Problem** narrative text field enter:

John FN2 was selling narcotics from the home putting Fred at risk for threat of harm.

In the **Begin Date** field

Enter: 10/03/2008

In the **Target Date** field

Enter: 07/03/2009

In the **Specific Task** group box, click **Insert**. In the **Desired Measurable Behavioral Outcome** narrative text field enter:

John FN2 will provide Fred with a living environment that is free of substance abuse and will provide Fred with age appropriate adult supervision.

In the **Specific Task** narrative text field enter:

John FN2 will complete a parenting class with 100% attendance and will demonstrate the skills learned during supervised visitation with Fred.

In the **Steps to Complete Task** narrative text field enter:

John FN2 will contact Child Guidance Center to enroll in a parenting class.

In the **Frequency** field

Enter: Weekly

In the **Specific Task Begin Date**

Enter: 10/03/2008

In the **Specific Task End Date**

Enter: 07/03/2009

In the **Other Provider/Ongoing Service Worker** field

Enter: Child Guidance

In the **Person Responsible** field

Enter: FN2, John (AD)

Select: **Basic Parenting Assistance**

Select: **Parenting Education - Classes**

Click **Save and Close**
In the **Case Participant Needs** group box:

Click the **Edit** hyperlink for FN1, Christina (AD) that states “Child does not demonstrate coping and problem solving skills, resiliency, and sense of identity.”

In the **Identified Problem** narrative text field enter:

Christina has become withdrawn and recently fought with another child at school.

In the **Begin Date** field

Enter: 10/03/2008

In the **Target Date** field

Enter: 07/03/2009

In the **Specific Task** group box, click **Insert**.
In the **Desired Measurable Behavioral Outcome** narrative text field enter:

Christina will learn to interact more effectively with her peers.

In the **Specific Task** narrative text field enter:

Christina will attend weekly counseling to address the effects of maltreatment and her behavioral problems.

In the **Steps to Complete Task** narrative text field enter:

Christina’s father, James FN3, will contact an appropriate child therapist to schedule appointments. Christina will actively participate in all scheduled therapy sessions.

In the **Frequency** field

Enter: **Weekly**

In the **Specific Task Begin Date**

Enter: 10/03/2008

In the **Specific Task End Date**

Enter: 07/03/2009

In the **Person Responsible** field

Enter: FN1, Christina (AD)

In the **Service Category** field

Select: **Routine/Emergency**

Mental Health Services

In the **Service Type** field

Select: **Mental Health Outpatient-Individual**

Click **Save and Close**
In the **Case Participant Needs** group box, click the **Edit** hyperlink for FN1, Christina (AD) that states “Concern about child’s academic performance, including attendance.”

In the **Identified Problem** narrative text field enter:

Christina’s academic performance has declined and she has been withdrawn at school.

- **In the Begin Date field** Enter: 10/03/2008
- **In the Target Date field** Enter: 07/03/2009

In the **Specific Task** group box, click **Insert**. In the **Desired Measurable Behavioral Outcome** narrative text field enter:

Christina will be able to concentrate more on her school work and will participate more in class.

- **In the Specific Task** narrative text field enter:

Christina will meet with her guidance counselor when she feels upset. Mr. FN3 will assist Christina with her school work.

- **In the Steps to Complete Task** narrative text field enter:

Mr. FN3 will provide a copy of Christina’s report cards and progress reports to the assigned Case Manager so that progress in her grades and behavior may be monitored. The Case Manager will also contact the school guidance counselor, monthly, to ensure that Christina is meeting with her when she feels upset.

- **In the Frequency field** Enter: Monthly
- **In the Specific Task Begin Date** Enter: 10/03/2008
- **In the Specific Task End Date** Enter: 07/03/2009

- **In the Person Responsible field** Enter: FN1, Christina (AD)

Click **Save and Close**
Click the **Ongoing Responsibilities** tab

Select “**Include Standards Caregiver Responsibilities**”

Click **Save**

Click the **Development** tab

Select Yes to “**This Case Plan Tasks is based on Family Assessment**”.

From the **Participation** dropdown boxes

Select **Participate** for FN1, Angela (AD) and FN2, John (AD)
Select **Did Not Participate** for FN3, James (AD)

From the **Type of Contact** dropdown boxes

Select **Face-to-Face** for FN1, Angela (AD) and FN2, John (AD)
Do not make a selection for FN3, James (AD)
Enter **contact date** of 10/03/2008 for FN1, Angela (AD) and FN2, John (AD).

**In the Explain why any participant did not participate in a face-to-face conference** narrative box enter:

Mr. FN3 did not participate in a face-to-face conference because he resides out of town. The Case Manager did speak with Mr. FN3 on the phone and he agreed to the case plan tasks.

**In the Describe the role of foster parents or legal custodians when developing the services that are to be provided to the child, foster parents, or legal custodians** narrative box enter:

Fred’s foster mother is providing transportation for all doctor’s appointments and transports Fred to the visitation center for visits.

**In the Describe the parents’ responsibility for financial support of the child, including but not limited to health insurance and child support** narrative field, enter:

Mr. FN3 will provide for all of Christina’s financial needs. Ms. FN1 and Mr. FN2 will pay child support for Fred as determined by the court.
Click the **Attachments** tab

In Medical/Mental Health
- Select checkboxes for all items

In Visitation Plan(s)
- Select checkbox

In Education
- Select Report Cards and Other school records
- Select Rights and responsibilities and Out-of-Home Plan

In the narrative field enter:

Not applicable; Christina does not have an IEP.

In the **Case Plan Tasks Information** header group box
- Select Completed

Click **Save** → Click **Close** → Click **Refresh** on the banner bar

Click the **Cases expando, Planning Icon**
Case Plan Goal

From the Desktop page, click Create on menu bar

Select Case Work from dropdown menu

From the Planning dropdown select Case Plan Goal

Select FN1, Angela from the list of cases the in Cases group box.

In the Case Participants group box

Select Christina FN1 from the list of child participants

Click Create to start a new Case Plan Goal

Select FSFN Task ID and Click Create

Reveals Case Plan Goal page

In the Expiration Date field in the header group box

Enter: 07/03/2009

In the Child's Proposed Goal group box

Select Reunification with parent(s) from the Primary Goal dropdown

In the Provide rational for goal choice; If not reunification or adoption, justify goal choice narrative text field

The mother is committed to addressing the issues that have prevented her from protecting the children. She has followed through with all recommendations and is making progress.

In the Safe & Appropriate group box for “Is the child’s current living arrangement or out-of-home placement safe and appropriate?”

Select Yes

In the Provide supporting information narrative text field

Christina is currently placed with her father in Hillsborough County. Even though Christina had not spend any time with her father previously, she is adjusting well. Christina gets along with her stepmother and half-brother. Christina’s father is meeting all of her basic needs and there is no indication of maltreatment in the home.

In the “Is the child a legal United States Resident?”

Select Yes
In the Master Trust group box, select the No radio button for each question:

Does the child have a master trust account established already?
If no, does the child need a master trust account established?

Click Save

Click on the TPR Considerations Tab and Review

This screen is used to document instances of expedited TPR or when a child has been in out-of-home care for 6 of the last 22 months. Neither situation applies to this case scenario.
Click the **Out-of-Home Care** tab

Select **Yes** to “Does the child’s case plan involve an out-of-home placement?”
Select **No** to “Does the child meet criteria for Rilya Wilson act?”
Select **No** to “Is the child placed with all siblings in out-of-home care?”

In the “**If No, describe the plan to place siblings together or reasons for separation**” text field enter:

Christina is placed with her father in Hillsborough County. Fred is placed in Foster Care. There are no relatives available to care for Fred.

In the **Placement Proximity** group box

Select: **No** for questions 1 and 2
Select: **Yes** for questions 3, 4, and 5

In the “**Provide supporting information for the above five questions**” narrative text field enter:

Christina was placed out of the county with her father. This has required her to change schools and not be in close proximity to her home. This is the least restrictive placement. Christina is able to have frequent telephone contact with her mother but due to the distance has not been able to see her mother since she was placed with her father.
In the “Describe the reasonable efforts to prevent removal or reunify the family or achieve the permanency goal” narrative text field enter:

Angela agreed to keep her paramour out of the home and to participate with Non-Judicial In-Home Services. Angela completed a drug evaluation and then relapsed. She left the children with her mother, Shirley, without provision for their care and without contacting Shirley, which resulted in the children being removed. Angela is currently working on her case plan to be reunified with her children.

Click Save

Click the Independent Living tab

Select checkbox “The child is not yet 13 years of age or the child is not in licensed foster care”

Click Save

In the Case Plan Goal Information group box

Select checkbox Completed

Click Save

Click Close
From the **Desktop**, click **Create** on menu bar

Select **Case Work** from dropdown menu

From the **Planning** dropdown, select **Case Plan Goal**

Select **FN1, Angela (AD)** from list in **Cases** group box

**In Case Participants** group box

Select **FN1, Fred (AD)** from the list of child participants

Copy **FN1, Cristina (AD) Case Plan Goal** into **FN1, Fred (AD) Case Plan Goal**

Select **FSFN Task ID**

Click **Create**

**In the Case Plan Goal Information** group box

Select **Completed**

Click **Save**

Click **Close and Refresh** on the banner bar

Click the **Cases** expando

Click the **Planning** icon

Click **Case plan task** for the **FN1, Angela (AD) family**

At the desktop

Select **Case Plan Task hyperlink** for the **FN1, Angela (AD) family**

From the **Options** dropdown on the **Strengths** tab

Select **Court Involved Case Plan** from the Options dropdown

Click **Go**

Click **Close and Return to FSFN**

Click **Save**

Click **Close and Refresh** on the banner bar
Module 3: Case Plan

Perform steps to launch the Voluntary Services Case Plan

From the Options dropdown on the Strengths tab
Select Voluntary Case Plan
Click Go

On the toolbar at the top of the page
Click Close and Return to FSFN

On the Desktop, click the Case Plan Goal hyperlink for FN1, Christina (AD)
The Case Plan Goal for FN1, Christina (AD) displays

In the Case Plan Goal Information group box
Select Completed; Should already be selected; if not, select

From the Options dropdown
Select Approval
Click Go
Select Approve
Select Continue
Select Close

Click Save and Close

Click the Case Plan Goal hyperlink for FN1, Fred (AD)
In the Case Plan Goal Information group box
Select Completed

From the Options dropdown
Select Approval
Click Go
Select Approve
Select Continue
Click Close

Click Save and Close
Click the hyperlink for the **Case Plan Task** from the Outliner

Select **Completed**

Click **Save**

From the **Options** dropdown

Select **Court Involved Case Plan**

Click **Go**

This will launch the Case Plan Template

Select **Close** and **Return to FSFN**

Click **Save**

From the **Options** dropdown

Select **Approval**

Click **Go**

Select **Approve**

Select **Continue**

Click **Close. Refresh the Desktop**
Second Level of Approval

From the **Options** dropdown

- Select: **Approval**
- Click **Go**
- Select: **Reroute**

In the **Supervisor Approval** box

- Select **Other** hyperlink

Click on the **Search** hyperlink next to Worker

Search for worker other than yourself

In the **Workers Returned** box, select the worker to receive your approval.

- Click **Continue**.

Click **Continue** again on the **Reroute Worker Approval** page

Click **Save** on the **Case Plan Tasks** page

Click **Close** to return to the Desktop
Module 4: Independent Practice

Case Planning Scenario Two

FN1, Barbara

An intake is received at the hotline on 04/15/2008 at 11:00 am regarding the FN1, Barbara Family and alleged that: “The mother, Barbara FN1, and boyfriend Leroy FN2, left the children home alone unsupervised for a long period of time (3:30 pm to 4:00 am). Barbara FN1 and boyfriend Leroy FN2, drink heavily. The children have gone hungry and have been seen wearing the same soiled clothes for three days. Barbara has three children, Gwen, age 8, Jean age 4, and Clyde age 17 months."

There is one prior on the family. In October, 2005, an intake was received alleging that 22 month old Jean FN1 was found wandering around her apartment complex unsupervised. Barbara FN1 was found intoxicated and passed out in the bedroom. The investigation was closed with verified findings of inadequate supervision and substance misuse (alcohol exposure). Judicial In-Home Services were put in place which included outpatient substance abuse counseling, AA classes, and parenting classes. Criminal history received on 04/15/08 for the mother, Barbara FN1, which includes one arrest in 2003 for a DUI charge which was later dropped. Telephone contact was made with the reporter, who verifies the allegations in the narrative and states that this is the third time that they were aware of that the children were left home alone. The man living in the home was named Leroy FN2 and is the father of the oldest child Gwen.

2:45 pm The intake was assigned to P.I. Denise Newman. She commenced the investigation on 4/15/2008 at 2:45 pm, by responding to the address listed on the intake, 1865 Riverdale Lane, Jacksonville, FL 32209. PI Denise knocked on the door, and Gwen FN2, age 8, answered. Gwen stated that her father was passed out on the couch again, and her mother had not been home since yesterday. With much coaxing, Gwen was able to wake her father.

2:55 pm PI Denise Newman introduced herself to Leroy FN2. She explained the dependency rights and responsibilities bulletin, and she conducted an initial interview with him. He provided the following demographic data:

Leroy FN2
White/Male
DOB: 01/21/1980
SSN: 878-78-8788

PI Denise Newman explained to Leroy his rights and responsibilities, and give him a pamphlet. After Leroy FN2 signs the required forms (HIPPA, TANF, ICWA, etc.), the allegations were reviewed with him. There were numerous empty beer cans and three empty beer cases scattered on the living room floor. Leroy had a strong odor of alcohol, and was slurring his speech. He stated the children’s mother, Barbara FN1, and he went out the other night to celebrate their engagement, and he felt that Gwen (8 yr. old) is old enough to watch the other children. He stated that Gwen is his child, but that he didn’t know who fathered the other two children.
Leroy and Barbara broke up when Gwen was 2, and he came back when Gwen was 6. Leroy denied drinking heavily or often, and stated he only drank socially. He indicated that he did not know where Barbara was. They had a fight and he has not seen her since. The refrigerator was observed to have only some condiment containers and beer. No food was observed in the freezer. The pantry was observed to have a can of peaches and 3 cans of vegetables. Leroy also stated that Barbara is responsible for the laundry, and that is why the children had to wear the same clothes for three days.

3:15 pm PI Denise Newman interviews Gwen (8-year old) in her room. Gwen shares a room with her sister Jean. PI observed bunk beds with soiled sheets. Soiled clothing was observed covering the floor. There were few toys observed in the room. Gwen stated that she often has to take care of Clyde, age 17 months and Jean age 4 years, because her parents are either passed out from drinking too much, or they often go out all night and don’t come home until the next day. Gwen stated that they are left home alone almost every weekend. She states that she gets afraid when her father drinks, because he will yell at them, and sometimes hit them. She stated that her father hit Clyde yesterday because he was crying, and now Clyde has a black eye. Gwen stated that when her parents left home the other day, the only things in the refrigerator were some hotdogs and juice. Gwen stated that she cooked the hotdogs for her brother and sister, but the food was gone by the morning. Gwen was wearing stained jeans and a t-shirt, and reports her mother has not done the laundry in a couple of weeks.

3:30 pm PI Denise Newman observed 17 month old child Clyde, in his room. Clyde has a toddler bed, which was observed to have no sheets on it. Clyde’s room also had soiled clothing on the floor and few toys. Clyde spoke but was difficult to understand. PI Newman observed Clyde to have purple bruising around his left eye about one-half inch wide on the temple side of the left eye. When PI asked Clyde what happened Clyde said, “da-da.” Clyde is also wearing stained jeans and a t-shirt.

3:40 pm PI Denise Newman attempted to interview Jean, age 4. Jean would not sit still, and ran around the house kicking the beer cans on the floor. Jean was dressed in a stained dress and had dirt and food stains on her face.

3:45 pm PI asked Leroy FN2 about the bruising to Clyde’s eye, and at first he stated that Clyde is very clumsy. He then stated that he really hadn’t noticed the bruising, and does not know how Clyde could have gotten a black eye. PI informed Leroy that Clyde would have to be seen at the Child Protection Team (CPT). Leroy denied any history of childhood abuse. Jacksonville Sheriff’s office (JSO) initiates criminal investigation. PI also request call outs, arrest records, and address checks. PI Newman contact her supervisor, and contacts CPT. An appointment is set for 4:30 pm. Background checks on Leroy FN2 were conducted. He has two arrests. (2000 disorderly Intoxication Conduct, and 2005 domestic violence).
4:00 pm  Jacksonville Sheriff’s Office (JSO) Deputy, D.C. Hendrix, began criminal investigation. Leroy FN2 admitted to hitting Clyde in the face because he would not stop crying. Officer Hendrix tells you that he would go with family and you to the CPT appointment to get their impression.

4:20 pm  PI contacted Children’s Legal Services attorney Robert Hill to staff the case. PI prepared the Legal Staffing form in preparation for staffing:

4:30 pm  Clyde, was examined by Dr. Marcus Johnson of the Child Protection Team. Clyde’s injuries are determined to be “diagnostic of abuse.” Clyde was also observed to have linear bruising on his back. Leroy FN2 admitted the bruising was due to him hitting Clyde with a belt. Officer Hendrix read Leroy FN2 his rights and arrested Leroy for Child Abuse and Child Neglect. Leroy advises the PI that the children should stay with their maternal grandmother, Theresa FN1, and her phone number is (904) 555-5789. Leroy stated that to his knowledge the children were not allergic to anything nor, were they taking any medications. PI completes the emergency intake form. Leroy FN2 signed a consent for treatment for Gwen. PI advises Leroy that the children would be removed for physical abuse and neglect and there would be a shelter hearing on 04/16/2008 at 9:30 am in the J1 courtroom at 500 E. Bay Street, Jacksonville, Fl 32202. PI spoke with the children and advised them that they would not be going back home because it was not safe for them to be left alone, and for their parents to be drinking alcohol excessively. The children were reassured that this was not their fault.

5:30 pm  PI telephones the maternal grandmother, Theresa FN1 and she is willing to care for the children. She provides her demographic information:

   Theresa FN1  
   White/Female  
   DOB: 05/16/1958  
   SSN: 867-39-2084  
   Address: 568 Elm Street, Jacksonville, Fl 32209

PI Denise Newman contacts the Crime Intelligence Unit at the hotline to request a background check on Theresa FN1. Theresa’s background checks are clear.

5:55 pm  PI Newman conducts a home study on Theresa FN1’s home. Theresa FN1 has a 3 bedroom 2 bath home in a quiet neighborhood. She also has beds for all the children and plenty of food in the home. Theresa FN1 needs a referral for daycare but otherwise can meet all the needs of the children. The home study is favorable and the children were placed with Theresa. Theresa FN1 agreed to supervise the visits between the parents and children. You advise Theresa of the shelter hearing on 04/16/2008 at 9:30 am in the J1 courtroom at 500 E Bay Street, Jacksonville, Fl 32202. You take photographs and fingerprints of the children. PI informed Ms. FN1 about the TANF funded TCA Program and the Relative Caregiver Program (RCP). PI provided Theresa FN1 with copies of the emergency intakes along with the Child Resource Records including copies of the Department’s consent for treatment forms and the medical consent forms.
On 04/16/2008, 9:00 am PI completes the Initial Safety Assessment and the case meets the qualifying criteria for second party review.

On 04/16/2008, 9:30 am PI attends the shelter hearing and the court finds probable cause for removal from the mother’s home and approved the recommended placement for the children at the maternal grandmother’s home. Supervised visits with the children was approved. Gwen’s father, Leroy FN2, appeared at the shelter hearing as well as his first appearance in the criminal charges. A review of shelter hearing/arraignment is scheduled for 04/28/2008 at 11:00 am. Leroy FN2’s bail is set for $25,000.

On 04/16/2008, 2:30 pm PI completes the FSFN safety plan, out-of-home plan, and family visitation plan.

On 04/17/2008, 1:30 pm The Early Services Intervention/Case Transfer is held with the Community Based Care agency and you are the Case Manager (CM) assigned as the primary case worker on the case. You have been provided with the address of Gwen’s father, Leroy FN2, who remains incarcerated at the Duval County Jail 423 Sinclair Court. Jacksonville, FL 32209 904-5413-6744.

You and your supervisor determine Reunification with the mother is the appropriate permanency goal for the children

On 04/17/2008, 3:50 pm You conduct a home visit (Theresa FN1’s home) to introduce yourself to the maternal grandmother and children. You interview all three children and the grandmother. All three children were clean and wearing non-soiled clothes.

Gwen had just returned from school. She was open and talkative when you spoke with her. She said that she has not seen her mother in two days and that she is scared for her because she drinks too much. She says that she is afraid of her father (Leroy FN2) and that she is glad he is in jail for hitting Clyde. She stated, “When he gets angry, he hits us.” Gwen is in the third grade, and she says she really likes school. She states that she “loves her grandmother very much.”

You interview Jean. She was smiling, but appeared a bit shy. She said she likes her school (Tot’s Daycare). When she was asked about her mother, she stated, “I miss mommy.” She ran out of the bedroom and hugged her grandmother.

You sit on the floor with Clyde, age 17 months, while he is playing with his trucks. When you ask Clyde about his mother, he said, “love mama.” Clyde exhibits physical characteristics normal for a 17-month old. He is friendly and appears to love his sister, Gwen, who came over to check Clyde’s diaper and to give him a big hug. Gwen continuously checked on Clyde during the visit.
You check the children’s bedrooms. All three children have their own bed. Clyde has a toddler bed with railings. All beds had clean sheets, and the house was found neat and orderly. The kitchen cabinets were stocked with food.

You interview Theresa FN1. The grandmother reports that her daughter (Barbara FN1) called this morning and stated that she has been staying at her friend’s (Missy Meck) house. Theresa said that Barbara was returning home today. Theresa says that Barbara has a bad alcohol problem and that she really needs help.

Theresa FN1 took Clyde, Jean, and Gwen to their pediatrician, Jacksonville Clinic; Dr. Mark Mercer, 5420 Lockville Blvd. Jacksonville, Florida 32299. The physician reports that all three children are healthy and reports no problems. All immunizations are up to date.

You provide Theresa with a daycare referral for Clyde, so she could enroll him in daycare. She stated she will enroll him in Tot’s Daycare where Jean attends. Reminded her that the shelter review/arraignment was scheduled for 04/28/08 at 1:30 pm.

On 04/17/08, 5:10 pm You conduct a home visit and meet the mother (Barbara FN1) in her home at 1865 Riverdale Lane, Jacksonville Fl 32209. Barbara provides the following demographic data:

Barbara FN1
White/Female
DOB: 01/22/1983
SSN: 555-13-1455
Telephone: 904 525-4596

You explain to Barbara her rights and responsibilities, and you provide her with a pamphlet. Barbara signs the required forms (HIPPA, TANF, and ICWA). You review the allegation with her. You inform her that her children are under court ordered out-of-home placement with their maternal grandmother.

Family Assessment: You Interview Barbara and the following is determined:

Barbara admits to having a substance abuse problem with alcohol and wishes to get help. She is currently in an unhealthy relationship with Leroy FN2 (Gwen’s father). Leroy left Barbara for another woman when Gwen was still a baby. He came back into Barbara’s life when Gwen was 6 yrs. old. Leroy can get violent at times and she has seen him hit the children. She states that she did not return home with him after celebrating their engagement the other night because they got into a fight at the bar. She was afraid that if she went home with him, she would have been beaten. She went to her friend’s house Missy Meck and stayed there (2240 NE Sawyer St., Jacksonville, FL 32209). She states, “I am glad Leroy is in jail. I do not ever want to see him again.”
Jean and Clyde both have different fathers. Jean’s father’s first name is James, but Barbara does not know his last name. She was only with him for a week. Barbara does not know who Clyde’s father is, as she was very intoxicated the night she got pregnant. She was raped by a man at a bar. She was afraid and did not file charges. She said she never knew his name.

Barbara’s mother, Theresa FN1, is very supportive of her and the three children and they have a good relationship most of the time. Theresa FN1, her mother, does not want Leroy in Barbara’s life or the children’s life.

Barbara has limited job skills. She worked at 7-11 as a cashier but was let go because she was often late for work (related to drinking). Barbara has a car and receives money for gas, food, and clothing for the children from her mother Theresa FN1.

Barbara admits to getting sick a lot because she is not taking care of herself properly, i.e., not eating, feeling stressed, drinking alcohol. She feeds her children whatever is easy, box cereal, canned soup, packaged foods. Barbara often relies on Gwen to care for Jean and Clyde. Barbara says she loves all three of her children and wants them to be happy.

Barbara was raised by her mother, Theresa FN1, and her father died when she was 2 years old in a work related car accident. Her father was a taxi cab driver. She was an only child. Barbara says she was never hit when she was growing up. She reports her mother was very good to her and that she is a very good grandmother to Gwen, Jean and Clyde.

Barbara feels stuck in life and wants help. She wants to quit drinking and get a job and provide a good life for her children.

You discuss services that are available. The following referrals were made and discussed with Barbara:

- Jacksonville Substance Abuse Treatment Center- Substance abuse evaluation – Follow the recommendations.
- Jacksonville Mental Health Facility– Psychosocial evaluation- Follow all recommendations.
- Alcoholics Anonymous– Provided pamphlet of AA meetings and suggested that she obtain a sponsor through AA.

You informed Barbara that she has a shelter review/arraignment hearing scheduled for 04/28/08 at 1:30 pm and you provide her with a copy of the notification form.
On 04/18/2008, 9:30 am  You conduct a face-to-face visit with Leroy FN2 at the Duval County Jail. Leroy FN2 is reserved and quiet during interview. Leroy does not believe that he has a problem with alcohol. He did not want to discuss anything that took place 04/15/08. You inform him that the shelter review/arraignment hearing is scheduled for 04/28/08 at 1:30 pm. He stated, “What does it matter if I go; the kids are Barbara’s problem, not mine.”

On 04/18/09, 10:25 am  PI Denise Newman informs you that she met with Children’s Legal Services and she reviewed and signed the petition for dependency. The petition alleged Substance Exposure, Inadequate Supervision, and Environmental Hazards, against the mother, Barbara FN1. The allegations against Leroy FN2 are Physical abuse, Inadequate Supervision and Environmental Hazards.

On 04/19/2008, 1:30 pm  You attend the multidisciplinary staffing to review the risks in the case and the safety plan. Decision was that the current safety plan is sufficient at this time. If/when Leroy FN2 is released from jail another staffing will be scheduled prior to his release.

On 04/24/2008, 11:00 am  You conduct a field visit to Tot’s Daycare to observe Jean and Clyde and to speak to their daycare staff. Mrs. Ranch stated that it is a pleasure to have Jean and Clyde in the daycare. There are no behavior problems or concerns. Observed Jean and Clyde interacting and playing with the other children in daycare. They were laughing and appeared happy.

On 04/24/2008, 11:50 am  You conduct a field visit to Gwen’s school; Rocky Road Elementary. You meet with Gwen’s Teacher Rachel Levi. She stated that Gwen is doing great academically and that she currently has all A’s. She reports no behavior problems with Gwen. You observed Gwen in the lunch room eating with her fellow students. Her interpersonal skills with the other students appear on target with her age. You observe her talking and laughing during lunch with her peers.

On 04/28/2008, 1:30 pm  Shelter review/arraignment hearing is held. The mother consented to the allegations on the petition. Leroy’s attorney consented to the allegations for his client, Leroy FN2. Barbara FN1 has been cooperative with the agency, and she is willing to receive services. The following was addressed: Referral completed, and the mother is to submit to substance abuse evaluation and follow all recommendations; referral completed and mother is to submit to a psychosocial evaluation and follow all recommendations; visits with the children will be arranged at least twice a month, and they are to be supervised by Theresa FN1. Daycare referral was completed for Clyde, and the grandmother enrolled him in daycare this 04/18/08. The court appointed a GAL for the children (Sherry Scamps). Disposition hearing is scheduled for May 9, 2008 at 9:15 am in room 220.
On 04/28/2008, 10:00 am  Completed the Family Assessment in FSFN. Submitted the family assessment to the Case Manager Supervisor.

On 05/01/2008, 2:40 pm  Received the results of Barbara FN1’s psychosocial evaluation that she completed on 04/29/08 at 9 am with Lorraine Phillips from the Jacksonville Mental Health Facility. The recommendations for Barbara FN1 are:

- Submit to a substance abuse evaluation,
- 8 week parenting classes, -once a week
- 24 weeks individual therapy –twice a week

Received results of Barbara FN1’s substance abuse evaluation that she completed on 04/30/08 at 10:30 am with Mark Alpern from the Substance Abuse Treatment Center. The recommendations for Barbara FN1 are:

- Outpatient substance abuse treatment
- 3 times a week for 16 weeks
- Attend support group such as Alcoholics Anonymous (AA)
- Obtain a sponsor through the support group

Referrals were completed for Barbara to enroll in all recommended services.

On 05/02/2008, 1:00 pm  You attend Mediation/Case Plan Conference/Family Team Conference to discuss assessment information and recommendations from evaluations and to draft the Case Plan. Barbara FN1 is cooperative and in agreement to all tasks and services. Case plan goal is Reunification with mother, Barbara FN1. Leroy FN2 declined to attend but chose to have his attorney present. Leroy was charged and convicted of physical abuse on 17 month old Clyde. He is sentenced to 7 years in prison.

The task and services that were agreed to for Barbara FN1 are as follows:

- Submit to a substance abuse evaluation, - Substance Abuse Treatment Center
- 8 week parenting classes, - Jacksonville Youth and Family Services Facility
- 24 weeks individual therapy– twice a week -Jacksonville Mental Health Facility
- Outpatient substance abuse treatment- 3 times a week for 16 weeks
- Attend support group such as Alcoholics Anonymous (AA)
- Obtain a sponsor through the support group
- Submit to random drug testing
- Show proof to Financially provide for the children’s needs.

The tasks and services that were agreed to for Leroy FN2 (Father to Gwen) were as follows:

Complete a psychosocial (mental health assessment) and follow all recommendations.

Attend parenting classes and submit a copy of his certificate of completion to the Case Manager.

Complete a substance abuse treatment evaluation and follow all recommendations.
On 05/05/2008, 3:15 pm You conduct a home visit to see the children at Theresa FN1’s (grandmother) house. You also observe a supervised visitation with the mother, Barbara FN1, and children. All three children appear happy and healthy and were wearing clean clothes. Barbara asked to have regularly scheduled supervised visits every day with the children after school/daycare from 3:00 pm to 5:00 pm. The grandmother agreed to supervise the visitation.

On 05/06/08, 9:10 am You speak with guardian ad-litem, Sherry Scamps. She observed interaction between the mother and the children during a supervised visit at the grandmother’s house. She explains that the grandmother is providing a safe, nurturing environment for the children and loves them dearly. She says the mom is really trying to stay sober, but she sees that it is difficult for her and that it is going to take time and support. GAL stated that she will submit her report to the courts for the disposition hearing scheduled for 05/9/08.

On 05/06/2008, 9:30 am All parties signed the case plan, and you file it with Children’s Legal Services.

On 05/09/2008, 9:15 am Disposition hearing is conducted. Judge accepts the case plan and the Initial Judicial Review hearing is scheduled 08/8/08.
Planning Worksheets: Case Planning Scenario Two

FN1, Barbara

Case Participants
Mother: FN1, Barbara (AD)
Gwen’s father: FN2, Leroy (AD)
Children: Clyde, age 17 months; Jean, age 4; Gwen, age 8
Grandmother: FN1, Theresa (AD)

Family Strengths, Supports, Resources
- Barbara has a close relationship with her mother, Theresa, and receives a great deal of support from her.
- The children have a loving relationship with their grandmother.
- Barbara lives in a house (rents).
- Barbara shows love and affection towards her children and has expressed her willingness to receive help for her substance abuse.

Permanency Goal: Reunification
Concurrent Goal: Permanent Guardianship with Theresa FN1, the children’s maternal grandmother

Needs
What are the child and family needs in order to assure child safety, well-being, and permanence?
- Clyde, Jean, and Gwen need to live in a home safe from physical abuse.
- Barbara needs to obtain employment in order to financially care for her children.
- Barbara needs to address her alcohol issues in order to care for herself and her children.
- Clyde, Jean, and Gwen need nutritious meals daily, need to be dressed in clean, non-soiled clothing, and need adult supervision at all times.
- Leroy needs to use alternative means of discipline that will not harm the children.
- Theresa FN1, needs to meet the children’s safety and well-being needs while the children are in her care.
**Identified Problems**

Problems are behaviors and/or conditions that result in risk to the child’s safety, permanence, and well-being. The family’s needs and problems are related to the maltreatments/reasons for agency involvement: Physical Abuse (Leroy), Environmental Hazards, Substance Exposure, Inadequate Supervision.

- Clyde has been a victim of physical abuse. The mother has failed to protect the children from Leroy when he becomes intoxicated and violent.
- Barbara FN1 is unemployed and has not been able to maintain a job to financially support herself and her children.
- Barbara FN1 abuses alcohol and has a substance abuse addiction which impairs her ability to care for and provide for her children.
- Barbara FN1 has left her children home alone, hungry, in soiled clothes, and without adult supervision.
- The 17 month old male child, Clyde FN1, was hit in the face by Leroy causing a black eye. Clyde also has linear bruising on his back caused by Leroy hitting him with a belt.
- The children must live in an out-of-home placement to assure their safety and well-being.

**Desired Measurable Behavioral Outcomes**

The outcome must state what can be done to eliminate the problem and address the need. State who is responsible and what he/she must do to eliminate risk to the child’s safety, permanence, and well-being.

- The mother, Barbara FN1, will provide her children with a living environment that is safe, permanent, nurturing, and free of physical abuse.
- Barbara FN1 will financially provide for her children’s needs.
- Barbara FN1 will provide her children with a living environment that is free of substance abuse.
- Barbara FN1 will protect and provide her children with food, clothing, shelter and constant adult supervision.
- Leroy will provide Clyde, Jean, and Gwen with a safe, nurturing environment free from physical abuse.
- The children’s maternal grandmother, Theresa FN1, will provide for the children’s safety and well-being while the children are placed in her care.
Tasks: Barbara

Tasks state WHO will do WHAT – and when, where, and how to accomplish the outcome. Tasks should address the child’s needs and also the causes that contribute to the problem.

Problem #1: Clyde has been a victim of physical abuse. The mother has failed to protect the children from Leroy when he becomes intoxicated and violent.

Measurable Behavioral Outcome #1: The mother, Barbara FN1, will provide her children with a living environment that is safe, permanent, nurturing, and free of physical abuse.

- Begin Date: 04/15/08
- Target Date: 01/15/2009

Specific Task: Barbara FN1 will partake in a psychosocial assessment to determine mental health strengths and needs and follow all recommendations.

Steps to achieve task #1:

The mother, Barbara FN1, will contact the Jacksonville Mental Health Facility to schedule an appointment for her psychosocial mental health assessment.

- Specific Task Begin Date: 04/15/2008
- Specific Task End Date: 01/15/2009
- Provider: Jacksonville Mental Health Facility
- Service: Mental Health Assessment
- Cost: $00.00

Task #2: The mother, Barbara FN1, will attend her psychosocial and will follow all recommendations.

- Specific Task Begin Date: 04/29/2008
- Specific Task End Date: 01/15/2009
- Provider: Jacksonville Mental Health Facility
- Service: Mental Health Assessment (psychosocial)
- Cost: $100.00
- Frequency: Weekly
Task #3: The mother, Barbara FN1, will attend regularly scheduled individual therapy sessions 2 times a week for 24 weeks.
   Specific Task Begin Date: 04/29/2008
   Specific Task End Date: 01/15/2009
   Provider: Jacksonville Mental Health Facility
   Service: Individual Counseling
   Cost: $50.00
   Frequency: Monthly, Sliding Scale

Task #4: The mother, Barbara FN1, will address any concerns or needs with the Case Manager regarding her individual counseling therapy sessions.
   Specific Task Begin Date: 04/29/2008
   Specific Task End Date: 01/15/2009
   Provider: child protection facility
   Service: Case Management
   Cost: $00.00

Problem #2: Barbara FN1 is unemployed and has not been able to maintain a job to financially support herself and her children.

Measurable Behavioral Outcome #3: Barbara FN1 will financially provide for her children's needs.
   Begin Date: 05/02/2008
   Target Date: 01/15/2009
   Specific Task: Barbara FN1 will obtain and maintain a verifiable source of income sufficient to meet her children's needs.

Steps to achieve task #1: Barbara FN1 will provide her Case Manager with pay stubs on a monthly basis.
   Specific Task Begin Date: 05/02/2008
   Specific Task End Date: 01/15/2009
Problem #3: Barbara FN1 abuses alcohol and has a substance abuse addiction which impairs her ability to care for and provide for her children.

Measurable Behavioral Outcome #3: Barbara FN1 will provide her children with a living environment that is free of substance abuse.

   - Begin Date: 05/02/2008
   - Target Date: 01/15/2009
   - Specific Task: Barbara FN1 will complete a substance abuse treatment evaluation and follow all recommendations.

Steps to achieve task #1: Barbara will contact the Jacksonville Substance Abuse Treatment Center to schedule a substance abuse treatment evaluation.

   - Specific Task Begin Date: 05/02/2008
   - Specific Task End Date: 01/15/2009
   - Provider: Jacksonville Substance Abuse Treatment Center
   - Cost: $50.00
   - Frequency: Weekly

Task #2: Barbara FN1 will provide her own transportation and attend the scheduled substance abuse treatment evaluation.

   - Specific Task Begin Date: 04/17/2008
   - Specific Task End Date: 01/15/2009
   - Provider: Jacksonville Substance Abuse Treatment Center
   - Cost: $10.00
   - Frequency: Weekly

Task #3: During the initial evaluation, Barbara FN1 will sign a release of information in order for the child protection agency to obtain progress reports from the provider.

   - Specific Task Begin Date: 04/17/2008
   - Specific Task End Date: 01/15/2009
   - Provider: Jacksonville Substance Abuse Treatment Center
   - Cost: $00.00
Task #4: Barbara FN1 will submit to random drug testing within 24 hours of request. Failure to comply will result in a positive drug screen.

Specific Task Begin Date: 04/17/2008
Specific Task End Date: 01/15/2009
Provider: Jacksonville Substance Abuse Treatment Center
Cost: $15.00
Frequency: Weekly

Task #5: Barbara FN1 will attend outpatient substance abuse treatment 3 times a week for 16 weeks.

Specific Task Begin Date: 04/15/2008
Specific Task End Date: 01/15/2009
Provider: Jacksonville Substance Abuse Treatment Center
Cost: $150.00
Frequency: Weekly

Task #6: Barbara FN1 will attend support group meetings such as Alcoholic Anonymous and obtain a sponsor.

Specific Task Begin Date: 04/17/2008
Specific Task End Date: 01/15/2009
Provider: Jacksonville Substance Abuse Treatment Center
Cost: $00.00
Frequency: Weekly
Problem #4: Barbara FN1 has left her children home alone, hungry, in soiled clothes, and without adult supervision.

Measurable Behavioral Outcome #4: Barbara FN1 will protect and provide her children with food, clothing, shelter and constant adult supervision.

   Begin Date: 04/17/2008
   Target Date: 01/15/2009

   Specific Task: Barbara FN1 will complete an 8 week parenting class with 100% attendance and will demonstrate the skills learned during supervised visitation with her children.

Steps to achieve task #1: Barbara FN1 will contact the Jacksonville Parenting Center to enroll in a parenting class.

   Specific Task Begin Date: 04/17/2008
   Specific Task End Date: 01/15/2009

   Provider:
   Cost: $15.00

   Frequency: Weekly

Task #2: Barbara FN1 will attend the parenting class once a week for 8 weeks and submit a copy of her certificate of completion to the Case Manager.

   Specific Task Begin Date: 04/17/2008
   Specific Task End Date: 01/15/2009

   Provider:
   Cost: $15.00

   Frequency: Weekly

Task #3: Barbara FN1 will demonstrate to the Case Manager her ability and knowledge in developing a well-balanced and nutritious meal plan for a week and a thorough preparation and clean up of at least one meal.

   Specific Task Begin Date: 05/02/2008
   Specific Task End Date: 01/15/2009

Task #4: Barbara FN1 will arrange for a responsible adult to supervise the children at all times if she is unavailable to do so and will notify the Case Manager of the adult’s name and date of birth.

   Specific Task Begin Date: 05/02/2008
   Specific Task End Date: 01/15/2009
Tasks: Leroy

Problem #5: The 17 month old male child, Clyde FN1, was hit in the face by Leroy causing a black eye. Clyde also has linear bruising on his back caused by Leroy hitting him with a belt.

Measurable Behavioral Outcome #5: Leroy will provide Clyde, Jean, and Gwen with a safe, nurturing environment free from physical abuse.
  Begin Date: 04/15/08
  Target Date: 01/15/2009

Task #1: Within five days of signing the case plan, Leroy FN2 will attend a psychosocial (mental health assessment) and follow all recommendations.
  Specific Task Begin Date: 04/17/2008
  Specific Task End Date: 01/15/2009
  Provider: Duval County Jail
  Service: (Psychosocial) Mental Health Assessment
  Cost: $20.00

Task #2: Within 10 days of signing the case plan, Leroy FN2 will attend parenting classes and submit a copy of his certificate of completion to the Case Manager.
  Specific Task Begin Date: 05/02/2008
  Specific Task End Date: 01/15/2009
  Provider:
  Service:
  Cost: $15.00
  Frequency: Weekly

Task #3: Within 10 days of signing the case plan, Leroy FN2 will complete a substance abuse treatment evaluation and follow all recommendations.
  Specific Task Begin Date: 05/02/2008
  Specific Task End Date: 01/15/2009
  Provider:
  Service:
  Cost: $15.00
  Frequency: Weekly
Tasks: Theresa

Problem #6: The children must live in an out-of-home placement.

**Measurable Behavioral Outcome #6:** The children’s maternal grandmother, Theresa FN1, will provide for the children’s safety and well-being while the children are placed in her care.

- **Begin Date:** 04/15/08
- **Target Date:** 01/15/2009

**Task #1:** Upon placement, 04/15/2008, and continuing until the court approves unsupervised visitation, Theresa FN1, will supervise visits with the children, Clyde, Jean, and Gwen.

- **Specific Task Begin Date:** 04/15/2008
- **Specific Task End Date:** 01/15/2009

**Task #2:** Beginning immediately, Theresa FN1 will ensure that Clyde and Jean attend daycare 5 days a week without any unexcused or 7 consecutive excused absences. She will ensure that Clyde and Jean are transported to and from daycare in a timely manner.

- **Specific Task Begin Date:** 04/15/2008
- **Specific Task End Date:** 01/15/2009

**Task #3:** Beginning immediately, Theresa FN1 will ensure the children’s medical and dental health maintenance and treatment by scheduling and taking them to appointments as needed.

- **Specific Task Begin Date:** 04/15/2008
- **Specific Task End Date:** 01/15/2009
Power Point Slides

Slide 1

Case Planning
FSFN

Slide 2

Module One

Objectives
- Deactivate a case participant from a case.
- Add case participants and their relationship to the caregiver.
- Update service roles for participants.
- Update addresses.
- Update person information/demographics.
- Document a living arrangement for the child.
- Update the Safety Plan.

Slide 3

Maintain Case Information

Maintain Case Information

All FSFN CASES are named after mother
If no mother: use father
If no mother or father: use oldest child's name
Case address current address of case name (mother)
AFCARS: If person is caregiver enter DOB, ethnicity, gender, & race
Maintain Case Screen

- Participant: used to add, deactivate or remove a case participant
- Relationship: defines relationship of one case participant to another
- Address: maintains primary address for case
- Professional/Other Contacts: maintains & update contact names/phone numbers
- Closing History: view, close &/or merged case history
- Open Date: date case is first created by hotline
- Restricted Case: high profile case or case where any employee is involved in an investigation & viewing is restricted.

Participant Tab

- Anyone assigned can deactivate a participant from a case
- End dates the person
- Participant can be reactivated
- All cases must have an active child
- Only a supervisor can remove a person from a case
- 24 hour waiting period before person is removed

Service Roles

- Primary Caregiver: person who assumes day to day responsibility for the child’s care & supervision; does NOT apply to babysitters
- Secondary Caregivers: assumes secondary day to day responsibility for the child
- Relatives/Non-Relative Caregivers: during the period they provide the child’s supervision or placement
- Case can have many active Primary Caregivers at one time
Service Roles

Custodial parent’s role as primary caregiver is:
• not end dated simply due to a removal episode
• only end dated upon Termination of Parental Rights

A single parent must be a primary caregiver

Person Management Address

Change the person address
• for each move made by a child & their caregiver

Estimate address begin & end dates if they cannot be verified
• use 01/01/YYYY format when year is known, or if month & year are known, use MM/01/YYYY

When the phone/email “type” is emergency contact or neighbor
• worker must enter person’s name to whom number belongs in comments section along with relationship

Person Management

Person information must be kept up-to-date.
If case is open, updates must be completed within 48 hrs. of information being known to worker assigned to case
Person Management Demographics

Primary name:
• must be legal name verified by B.C., SSN, or court document.
• must match name used on document to verify name in question

Search is required prior to changing “Unknown” name

SSN: Primary must be used (when known) as ID in order to avoid eligibility errors; other ID’s may be used in addition to SSN – Primary

DOB: month, day, & year person was born; declared, or estimated; required for each person

If using Drivers License or Medicaid #, enter the first two letter standard postal abbreviation of the state that generated the ID

If DOB not declared - estimate with 01/01/YYYY

The client defines his/her race or ethnicity and that of his/her children

Placements

• Living Arrangements: child is living with a parent or permanency is achieved with a relative/non-relative with the permanency.

• Out-of-Home Placement: child has been removed from the home and place.
Module Two

Objectives:
• Create a family assessment.
• Create the child assessment.
• Create the adult assessment.
• Document case notes.

Family Assessment
• Initial family assessment w/in 15 working days after ESI staffing.
• You must complete ongoing family assessment at least every 6 months until services terminate.
• Family assessment involves you & the family: joint effort to identify & analyze family strengths, contributing factors & underlying conditions that jeopardize child safety & maltreatment risk.

Case Header Group Box
• Case Name
• Assessment Date
• Status
• Pending
• Approved
• Changes based on case approval
• Created by
• Purpose
• Initial
• Updated
Slide 16

**Participants Group Box**

- The Participants tab: default tab of Family Assessment
- Lists active participants in Case

**Names**
- Pre-fills with names of case participants
- Clicking any name launches Person Management screen

**DOB**
- Birth Date pre-fills from Person Management

**Gender/Pre-Risk from Person Management**

**Mental Status**
- Pre-fills from Person Management

**Service Role**
- Pre-fills participant's Service Role from Maintain Case

**Child/Adult**
- Each participant row has Child, Adult, or Child/Adult hyperlink
- Hyperlink launches Assessment pop-up page

Slide 17

**Prior Intakes/Investigations**

There are two group boxes on this tab:
- Prior Intakes
- Prior Investigations/Referrals

Displays the prior intakes & investigations/referrals for each participant in Family Assessment

Each record has View hyperlink

Slide 18

**Prior Intake Group Box**

- Date (Date the intake was received)
- Intake Number
- Intake Name
- Intake Type
- Screening Decision
- Case ID
- Finding (Overall Investigation Finding)
- Investigative Sub Type
- Worker Safety Concerns
Slide 19

Prior Investigations /Referrals

<table>
<thead>
<tr>
<th>Intake ID</th>
<th>Case Name</th>
<th>Case ID</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intake Type</th>
<th>Investigative Sub Type</th>
<th>Finding</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status</th>
<th>Date Closed</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Slide 20

Family Tab

Third tab on Family Assessment page

Information about family’s strengths and needs

Two group boxes

- Factors
- Agency Involvement Factors

Slide 21

Family Tab Factors

4 required radio buttons

- Reason for Agency Involvement
- Cultural
- Environmental Factors
- Input/Involvement

Each contains statements/questions specific to the subject area for the factor
Slide 22

**Safety Tab**
- Addresses the imminent safety
- and future risk in family specific areas
- Safety
- Emerging Dangers
- Two radio button factors on the Safety tab:
- The Safety Factors group box
  - consists of two questions
  - Required narrative field
- Yes or No responses
  - required for each question

Slide 23

**Header Case Group**
Remains constant when tabs are selected.
- Name & service role are pre-filled
- Meets independent living criteria;
- pre-filled if child is 13 or older & in licensed care
- Completed checkbox performs validations check when saving

Slide 24

**Child Assessment**

- **Permanency**
  - Placement & Permanency
- **Vulnerability**
  - Well-being
  - Health Behavioral Health Education Social
  - Fragility Behavior Adjustment

---

CM 123_CP_FSFN_PPT_July 2013 (CM 121 CP_FSFN)
PowerPoint Slides
Slide 25

Module Two: Family Assessment

- Adult Assessment
  - Functioning
    - Health
    - Intellectual
    - Communication
  - History
    - Abuse
    - Criminal
    - Financial
  - Relationships
  - Domestic Violence
  - Support Network
  - Protective Capacities
  - Expectations of Child Participation
  - Parenting
  - Abuse
  - Criminal
  - Financial

Slide 26

Module Three

Objectives

- Describe the FSFN Initial Case Plan.
- Identify Strengths & Needs in a family to develop Case Plan tasks.
- Determine Case Plan Goal.

Slide 27

Case Plan

- The Case Plan is a document prepared by the department with input from all parties, which follows the child from the provision of services through any dependency, foster care, or termination of parental rights proceeding or related activity or process. F.S. 39.01(11)
Slide 28

**Case Plan Tasks Information**

- Pre-filled Case & Worker Names
- FSFN Task ID: unique system generated identifier
- Case plan Status – pre-filled
- Pending – not approved by supervisor
- Approved – approved by supervisor
- Expiration date – date task expires
- Date supervisor approved
- Completed – used to validate information

Slide 29

**Strengths**

- Carried forward from Family Assessment
- Narrative text field used to document pertinent family information
- User provides analysis of family strengths and how they will be used

Slide 30

**Attachments**

- Medical/Mental Health
- Visitation Plan
- Education
- Master Trust